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' Always show me suspect certificates: Aventail Connect will display

suspect certificates each time they are received. The Certificate dialog

box will appear for each new connection to the server(s) sending a sus-

pect certificate. (This option allows you to continue the connection

despite the fact that the certificate is questionable.) The SSL module

authenticates the server’s certificate based on the following questions:

- Is the certificate valid?

- Did a trusted certificate authority (CA) issue the certificate?

- Is the name established by the certificate the same as the name of
the server for this connection?

If a certificate does not pass all three tests, it is considered a suspect certifi-
cate.

- Show me the same certificate once: Aventail Connect will display a

suspect certificate the first time that it is received. If you choose to

maintain the connection, the questionable certificate will not be dis-

played again during the current session.

- Show me the certificate, but reiect the connection: Aventail Con-

nect will reject a connection if the certificate is suspect. It will display the

certificate to allow you to vi ew it.

4. Click Advanced in the dialog box to show the acceptable cipher (a crypto-

graphic algorithm used to encrypt the data stream) options.
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Allow RC4 Offer the RC4 cipher to the server.

Allow DES Offer the DES cipher to the server.

Allow NULL Encryption Do not encrypt using SSL. SSL will be used to

authenticate only.

Allow Diffie—He||man Do not authenticate the server; only do encryption.

Anonymous

Enable Compression Use SSL compression to improve performance when
slower connections are detected.

Trusted Roots Select a certificate file that specifies trusted certificate

chain roots. and specify the maximum allowable

certificate-chain length.
NOTE: The trusted root tile MUST be placed in the same drrectoqr as the
Aventail Connect configuration file.

Select the specific file

Client Certificate Select a client certificate file.

NOTE: The client certificate MUST be placed in the same directory that
Aventail Connect was installed to.

Select the specific file

During the initial SSL connection, the client and the server negotiate which

cipher to use. Checking a particular cipher in the dialog box does not mean

that it will be used. Instead, each checked cipher is offered to the server, but

the server determines which cipher to use. if the server requires a cipher that

is not selected in this dialog box, the authentication will fail.

Any or all of the acceptable cipher options can be selected:

- Allow RC4: Aventail Connect encrypts the information using the RC4

cipher.

- Allow DES: Aventail Connect encrypts the information using the DES

cipher.

- Allow NULL Encryption: Aventail Connect allows the server to select

no encryption. Message integrity is still assured, but the data will be
sent in cleartext.

- Allow Diffie-Hellman Anonymous: Aventail Connect will be able to

communicate with the extranet (SOCKS) server without requiring a

server certificate. The client and server will not exchange certificates,

so there will be no authentication. The encryption will still be negotiated,

and the data stream will still be encrypted (unless NULL encryption is

chosen by the server).
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' Enable Compression: To speed the encryption process and enhance

overall performance. Aventail Connect will automatically compress

encryption when a narrow bandwidth andior slow modem are detected.

5. If necessary, add (or delete) a trusted root (* . rot) to (or from) the list of

trusted roots by clicking Browse. Only the filename of the roots file loads via

the Browse button, and not the pathname.

CA UTION: The trusted root tite must be in the same directory as

the Aventail Connect configuration file.

If Aventail Connect sends a client certificate to the server during the initial

authentication exchange, it sends the certificate identified in the Client Certif-

icate window. To load the client certificate, press Browse and then select the

client certificate (* . cer) from the Aventail Connect directory. Only the file-

name of the certificate file loads via the Browse button, and not the path-
name.

 _ CAUTION: The ciient certificate tite must be ptaceo‘ in the Aventaif
Connect directory.

When Aventail Connect receives a certificate from a server, it looks at the root

of the certificate chain and matches it against the Aventail Connect list of
trusted roots.

You can specify the maximum number of certificates in a certificate chain. The

default maximum length is two certificates. In most instances, Aventail recom-

mends allowing no more than two certificates to form a chain, although you

can specify up to ten. The longer the certificate chain, the less secure the
chain is.

CA UTION: in most instances, Aventait recommends aiiowing no more

than two certificates in a certificate chain. Attowing more

than two certificates can compromise security.

6. After making appropriate selections, click OK.

The dialog box closes and the Config Tool reappears.

ADVANCED TAB OPTIONS

The Advanced tab in the Config Tool contains three advanced options. In the

Advanced tab, you can allow SOCKS tunneling through successive extranet

(SOCKS) servers, secure selected applications, and set credential cache time-
outs.
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ALLOW SOCKS TUNNELING THROUGH SUCCESSIVE EXTFIANET SEFWEFIS

Once sewers and destinations are defined, you can direct SOCKS traffic

through successive extranet (SOCKS) servers.

On the Advanced tab in the Config Tool, select the Enable redirection... box to
allow credential information to fonlvard to successive extranet servers.

SECURE SELECTED APPLICATIONS

This option allows you to:

- secure all applications except those listed,

- secure only the applications that are listed,

- or secure all applications, enabling neither exclusion nor inclusion.

NOTE: You can exclude and include only 32-bit applications. You cannot

exclude and include 16-bit applications.

You can exclude or include specified applications in the Exclusioniinclusion List.

With the Exclusionllnclusion List, you can secure all applications except those

on the list, or you can secure only those applications on the list. The default set-

ting is to secure (hook) all network applications.
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Excluding Applications

You can exclude specific applications through the Exclusionilnclusion List. When

you enable the “Secure all applications except listed” option, Aventail Connect

will not proxy any applications that are on the Exciusionilnclusion List.

To exclude an application

1. Under “Applications to Secure,” select Secure all applications except listed

and click Modify List.

 
The Edit List dialog box appears.

 
2. Click Add....
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The Specify Application dialog box appears.

Lchnkjrlt i'5fiF'rograrn VI El
§ Spellflhk

E netscapee:-:e
E N |:i'W'rap. e:-ce

nsnotify. ene

 

 
 

 
   

 

 

F3138 ofype: |i'-applications ‘I ca,-.ce| | 

3. Highlight the application(s) to add to the Exclusionilnclusion List, and then

click Open.

The Specify Application dialog box disappears and the applications are now

in the Edit List dialog box.

4. In the Edit List dialog box, select All occurrences or Only this occurrence.

NOTE: You may have more than one path (instance) of a specified flie-

name (e.g., ftp . exe). You can choose to exclude one specified

appiication, with a tuiiy quaiified pathname (e.g., C : \win-

dows\ Sys3 2 \ ftp . exe), or ail‘ instances of a specified fitename

(e.g., aii instances of ftp.exe).

 

- Only this occurrence: Selecting this option excludes only the speci-

fied application.

- All occurrences: Selecting this option excludes all applications with

the specified filename.

To undo application exclusion

1. Under “Applications to secure,” select Secure all applications except listed,

and then click Modify List.

The Edit List dialog box appears.

2. Highlight the application you want to remove from the Exclusionilnclusion List,
and then click Remove.

The application is removed from the Exclusionilnclusion List.
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inciuding Appiicarions

You can include specific applications through the Exclusion/inclusion List. When

you enable the “Secure only applications listed" option, Aventail Connect will

hook only those applications that are on the Exclusionilnclusion List.

To include an application

1. Under “Applications to secure," select Secure only applications listed, and

then click Modify List.

The Edit List dialog box appears.

2. Click Add.

The Specify Application dialog box appears.

3. Highlight the application(s) to add to the Exclusionilnclusion List, and then

click Open.

The Specify Application dialog box disappears and the applications are now

in the Edit List dialog box.

4. In the Edit List dialog box, select All occurrences or Only this occurrence.

NOTE: You may have more than one instance of a specified application

(e.g., ftp . exe). You can choose to inciude one specified appli-

cation, with a fuiiy quaiified pathname (e.9., C : \Win—

dc-ws\ Sys3 2 \ ftp . exe), or aii instances of a specified

appiication (e.g., aii instances of ftp . exe).

 

- Only this occurrence: Selecting this option excludes only the speci-

fied application.

- All occurrences: Selecting this option excludes all applications with

the specified filename.

To undo application inclusion

1. Under “Applications to secure," select Secure only applications listed, and

then click Modify List.

The Edit List dialog box appears.

2. Highlight the application you want to remove from the Exclusionilnclusion List,
and then click Remove.

The application is removed from the Exclusionilnclusion List.

Securing ail Appiications

You can secure at! applications, enabling neither exclusion nor inclusion. When

you secure all applications, Aventail Connect ignores any applications on the
Exclusionilnclusion List.
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To secure all applications

' On the Advanced tab, under “Applications to Secure," select Secure all

applications.

NOTE: Aventail Connect secures all applications by default. Unless you

need to exclude or include specific applications, Aventail recom-

mends that you use the default Secure all applications setting.
 

net information Server {ilS) and Microsoft Peer Web Server)
include inetiniaexe, which conflicts with Aventail Connect

3.01. To eliminate this conflict, exclude inetinloexe through

the Application Exclusion/inclusion List in the Coniig Tool.

 ' CAUTION: Microsoft internet server products (including Microsoft inter-

CREDENTIAL CACHE TIMEOUTS

With the credential cache timeout feature, you can control when credentials

expire (time out). If a user has not made a connection to the extranet (SOCKS)

server for a certain length of time (determined by the administrator). then the

credentials will automatically be deleted from the credential cache. if a credential

times out, the user must reauthenticate by entering the proper credentials before

regaining access to the extranet. This feature can help to prevent unauthorized

users from gaining access to secured areas.

9v Conlig Tool - C:‘s...\Aventai|\Aventai|.clg

Eilei flelp 7 A 7 ‘  
 

 
 
 
 
 

 

Fledirection Flules I Servers I Destinations I
Local Name Resolution AUVGVICBU I Authentication I

 

 
 
 

l- Enable redirection through successive SUCKS sewers.

Applications to Secure

5' Secure all applications _ _
1" Secure all applications except listed tjodriy LI5;l

1"‘ Secure gnly applications listed

Credential Timeouts

in flever time out cached credentials.

F Time out credentials lrom tinefirst entered. _.l .
r-* ""used"""""‘ l‘“ _-r '*"'"-uulm-...r.¢...................uu-.M.u.4.n-A-r.|-s .«-u-q.a.._.._,..._.

  
 

  
There are three credential cache timeout options.

- Never time out cached credentials: Credentials never time out.
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' Time out credentials from time first entered: Credentials time out x

minutes after the user first entered the credentials (where “x” is the

number of minutes you enter in the Min. box).

- Time out credentials from time last used: Credentials time out Jr min-

utes after the user last connected through the extranet server (where

")4" is the number of minutes you enter in the llllin. box).

regular intervals, the mall-checking frequency must be

longer than the credential cache timeout. For example, if

your mall program ls configured to check for mall every

ten minutes, you should set the credential cache to less
than ten minutes.

 . CA UTl0l\l: ll‘ your mall program is configured to check for e-mall at

ENABLE PASSWORD PROTECTION

You can enable password protection for a configuration file. If you enable pass-

word protection, users will not be able to view or modify the configuration file

without the assigned password. A password is not required to use the configura-
tion file with Aventail Connect.

To enable password protection

1. From any tab of the Config Tool, select File I Set Password.

33- [Ioniig Tool — E:\...\Avenlail\.l5.venlai|.clg

EZ:kF'rog1am Fi|'es\itli.veritail\l!l.ventai|. cfg 
The Configuration File Password dialog box will appear.

2. Enter the desired password.

3. Reenter the password to confirm, and then click OK.
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To disable password protection

1. From any tab of the Config Tool, select File I Set Password.

The Configuration File Password dialog box will appear.

2. Clear the password from both boxes. and then click OK.

NOTE: if you save an existing configuration fiie using the Save As com-

mand, Avenfaii Connect wiii prompt you to enter the correct pass-

word for the configuration fiie.
 

MULTIPLE FIREWALL TRAVERSAL

To gain access to your extranet, users may need to traverse multiple firewalls. In

the simplest case, this involves an employee at a partner company gaining

access to the Internet via an outbound proxy server at the partner company, and

having an authenticated, encrypted, and controlled connection to your internal

network via an Aventail ExtraNet Server. This capability is provided in Aventail

Connect 3.01 by the Aventail MultiProxy feature. Aventail Connect can open

connections through SOCKS servers, through HTTP proxies, or through proxy

chaining.

- MultiProxy with SOCKS Server: Uses a SOCKS server to control out-
bound access.

° MultiProxy with HTTP Proxy: Uses an HTTP proxy to control out-
bound access.

- Proxy Chaining: Uses two Aventail ExtraNet Sewers, where one
Aventail ExtraNet Sewer acts as a client to another Aventail ExtraNet

Server.

AVENTAIL MULTIPROXY

The Aventail MultiProxy feature allows Aventail Connect to traverse multiple fire-

walls by making connections through successive proxy servers. Aventail Con-

nect makes a connection with each proxy server individually. Each proxy server
forms a link in a chain that connects Aventail Connect to the final destination.

Any or all of the proxy servers can apply authentication and access control rules.
Proxies can be Aventail ExtraNet Sewers, other SOCKS 5 servers, SOCKS 4

servers, or HTTP proxies.

Using an HTTP proxy server to control outbound traffic eliminates the need to

install a separate SOCKS server. This HTTP proxy can filter outbound connec-

tion requests and route those requests to the specified servers. MultiProxy sup-

ports RFC 2068 HTTP Basic (usernameipassword) authentication. If your proxy

uses HTTP Basic (usernameipassword) authentication, Aventail Connect will

store the username and password information in the credential cache, as it does
with SOCKS sewers.
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NOTE: The MuitiProxy feature supports the use of HTTP proxies in

Aventaii Connect 3.01 oniy. HTTP proxies cannot be used in
A ventaii Connect 2.51.

The steps for making a connection using MultiProxy are:

1. The client application requests access to the destination server.

2. Aventail Connect establishes a connection with the outbound server (SOCKS

sewer or HTTP proxy). Aventail Connect then sends the access request to

the outbound sewer, specifying the Aventail ExtraNet Sewer as the destina-

tion. The user authenticates with the outbound server, if necessary.

3. Aventail Connect instructs the outbound server to establish a connection with

the Aventail ExtraNet Sewer on the specified port. The user authenticates

with the Aventail ExtraNet Sewer, if necessary.

4. Aventail Connect instructs the Aventail ExtraNet Server to proxy its connec-
tion to the final destination.

5. Once the connection between the client and the Aventail ExtraNet Server is

established, the outbound server simply relays the data.

The following example illustrates the connections made during a MultiProxy con-

nection through three proxy sewers.

IE    

 
 

Aventail Cc-rnect |:ur::o<y 1 proxy 3

. I I I |

tonne-:|:Ion #1  -ISKKS I l :
connezticun #2  :5mKS : I

connection #3 :SCICKS :I
:I:Inna:tiI:In #4 lapplicalj tn

In the following diagram, the Aventail ExtraNet Server acts as both a destination

and a server. It is a destination because a proxy sewer routes traffic to it. It is a
sewer because it routes traffic to the final destination.

 
 
 

d 2

final destination

crI_IH:n:III_Ind proxy server »'-‘l.1rentai| ExtraNetCenter server
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CA UTION: if using an HTTP proxy, you must configure your HTTP

proxy and fire wait to aiicw HTTPS/SSL connections to

port 1080, OR you must run the Aventaii ExtraNel‘

Server on port 443 or part 563.

Configuring Aventaii il/fuitiProxy

You have two options for configuring Mu|tiProxy. You can configure Aventail

Connect 3.01 to redirect all Internet traffic (including extranet traffic) through

your outbound proxy, or you can configure Aventail Connect 3.01 to redirect only

extranet traffic through your outbound proxy.

To configure Aventail I'li|ultiProxy

1. Create a destination (“Final destination”).

2. Create a server (“Extranet server”).

3. To redirect only extranet traffic: Create a destination ("Extranet server"),

using the same information from step 2, above.

_0R_

To redirect all Internet traffic (including extranet traffic): Create a destina-

tion (“Local network,” the network local to Aventail Connect).

NOTE: if you have muitipie domains or subnets, you may need to create

muitipie destinations.

4. Create a server (“Outbound proxy”). This can be a SOCKS 5, SOCKS 4, or

HTTP proxy server.

5. Create a redirection rule (Redirect “Final destination" through "Extranet

sewer").

6. To redirect only extranet traffic: Create a redirection rule (Redirect “Extra-

net server" through “Outbound proxy”). Do not redirect “(everything else)."

..OR..

To redirect all Internet traffic (including extranet traffic): Create a redirec-

tion rule (Do not redirect “Local network"). Redirect "(everything else)" through

the outbound proxy. (NOTE: Your outbound proxy must belong to “Local net-

work.”')
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J ln.-II Un.':l|*.'.'I

Redirect only the extranet traffic through Redirect all Internet traffic throuh the

the outbound proxy. Leave all other outbound proxy. Leave only “Local network”
traffic alone. traffic alone.
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Pnoxv CHAINING

Proxy chaining is an Aventail ExtraNet Server feature. With proxy chaining,
Aventail ExtraNet Servers forward connections for certain destinations to other

DFOXY SBNBFS.

The following diagram and table illustrate the differences between MuItiProxy

and proxy chaining. In many cases, Mu|tiProxy is the preferred method for tra—

versing multiple firewalls. With Mu|tiProxy, each proxy server can provide

authentication, access control, and encryption.

PRl2|X‘I' EHAIHIHE: Serverl appears as a user to server2.

 

 

Aventail Connect serverl Destination server

client (outbound) |:l:WE.'l'Itai| Extrali-let
Server)

MULTIPRDXV: The user authenticates with server2 directlv.

!'1"!FoIFulfiI

Aventail Connect serverl server? Destination server

client (outbound) Ifiifiventail Extrahlet
Server)

{ii Authenticated and encrypted tunnel
In Mu|tiProxy, an authenticated and encrvpted
tunnel exists between the client and the Fiventail
Extralflet Server. 
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Mulh‘Proxy Proxy Chaining
Server 1 Can be Aventail ExtraNet Must be Aventail ExtraNet

Server, other SOCKS 5 server, Server.

SOCKS 4 server, or H'|'|'P
proxy.

Server 2 Must be Aventail ExtraNet Must be Aventail ExtraNet

Sewer. 1 Server.
Authentication User authenticates (if User authenticates.

to Server 1 necessary).

Authentication User authenticates. Server 1 authenticates

to Server 2 automatically.

Trust model for I Not inherited. Each user must I Inherited from Server 1. Server
Server 2 individually authenticate with 2 trusts everyone who

Server 2. authenticates to Server 1

1 equally.
Access control Can be for specific users. Treats everyone who
rules authenticates to Server 1

equally.

Client

configuration
redirection rules ' r- :-

s..\dlhIPofir)1I')D';I | aauud I muwvrr-wn. |

 
Advantages - Server 1 can be an Aventail - Client is aware of Server 1

ExtraNet Server, other SOCKS only.

5 server, SOCKS 4 server, or - User authenticates only once.

HTFP proxy. to Server 1.
- Most secure. because no

security policy is inherited from
Server 1.
 

Disadvantages - User may need to authenticate ° All users connecting through

more than once. Server 1 appear as a single
- Client must be aware of user to Server 2.

Server 1 and Server 2.
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HTTP PFIOXIES AND WEB Bnowsens

Extranets often include Web pages that must be viewed with a Web browser.

When a Web browser uses an HTTP proxy server, Aventail Connect sees con—

nections being made to the HTTP proxy rather than to the final destination.

Therefore, Aventail Connect cannot redirect the connections to the Aventail

ExtraNet Server or provide authentication and encryption. For Aventail Connect

to function properly, the Web browser cannot use the HTTP proxy to connect

with sites protected in the extranet; this is because Aventail Connect must redi—

rect and encrypt connections. The Web browser can still use the HTTP proxy to

connect to sites that are not protected in the extranet.

If access to Web pages behind the Aventail ExtraNet Server requires users to

connect through a Web browser (e.g., Microsoft Internet Explorer or Netscape

Navigator), you must configure the Web browser to not use the HTTP proxy in

the Web browser for those sites protected in the extranet.

When users need to access Web pages behind an Aventail ExtraNet Server. you

must properly configure the Web browser.

Configuring Aventail Connect and the Web Browser

There are two approaches to configuring Aventail Connect for use with a Web
browser.

- Configure the Web browser to not use the HTTP proxy for any traffic.

(Aventail Connect redirects all connections through the outbound

proxy.)

..OR..

- Configure the Web browser to not use the HTTP proxy for only those

sites that are protected in the secure extranet. (Aventail Connect redi-

rects only extranet connections through the outbound proxy.)

To use either approach, you must first configure Aventail Connect. The Aventail

Connect configuration is the same for both approaches, whether you are config-

uring your browser to not use the HTTP proxy for all traffic or for protected sites

only.

To configure Aventail Connect for use with a Web browser

‘I. In the Servers tab of the Config Tool, add the HTTP proxy as a server.

2. In the Destinations tab of the Config Tool, add the HTTP proxy as a destina-
tion.

3. In the Redirection Rules tab of the Config Tool, edit the "(everything else)”

rule to redirect all traffic to the HTTP proxy server.

4. In the Redirection Rules tab, select the HTTP proxy and select the Do not

redirect option.
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CA UTION: Make sure you do not redirect the outbound proxy.

Redirecting the outbound server or proxy wiii instruct

the outbound proxy to redirect traffic to itseif, causing

Aventaii Connect to behave unpredictabiy.

To configure the Web browser to not use the HTTP proxy for all traffic

After you have configured Aventail Connect by following the instructions above,

configure the Web browser by using one of the following procedures.

- Microsoft Internet Explorer

a. On the View menu, click Internet Options.

b. Click the Connection tab.

c. Click to clear the Access the Internet using a proxy server check box.

- Netscape Navigator

a. On the Edit menu, click Preferences.

b. Under “Category,” click to expand Advanced, and then click Proxies.

c. Select Direct Connection to the Internet, and then click OK.

To configure the Web browser to not use the HTTP proxy for protected

sites only

After you have configured Aventail Connect, configure the Web browser by

using one of the following procedures.

- Microsoft Internet Explorer

On the View menu, click Internet Options.

Click the Connection tab.

Under “Proxy Server," click Advanced.9-???’
In the Exceptions box, type the URL of each site that is in the protected
extranet.

- Netscape Navigator

On the Edit menu, click Preferences.

Under “Category.” click to expand Advanced, and then click Proxies.

Select Manual Proxy Configuration, and then click View.P-P579‘
In the Exceptions box, type the URL of each site that is in the protected
extranet.
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CONFIGUFIING THE HTTP Pnoxv

To allow SSL connections to destination ports other than 443 (https) and 563

(snews), you may need to configure your HTTP proxy. Typically, if you plan to

connect to a SOCKS server on port 1080 using an HTTP proxy, you must

change the HTTP proxy configuration.

To avoid changing the HTTP proxy configuration, you must run the destination

Aventail ExtraNet Server on port 443 or port 563. and configure Aventail Con-

nect accordingly.

lvlost HTTP proxies can allow connections to port 1080. The following instruc-

tions describe how to configure the Microsoft Proxy Server, Netscape Proxy

Server, or Apache Web Server to allow port 1080 connections.

- Microsoft Proxy Server 2.0: Follow the Microsoft instructions at

http:/!support.microsoft.comlsupportl'kbr‘artic|es!q184./OI28.asp.

You must modify a registry setting with regedt32 .exe.

(regedit . exe will not work; you must use regedt32 . exe.)

- Netscape Proxy Server 3.5: Add the following to your obj . conf file:

<Object ppath="connect: //*"> (all ports)
Service fn="connect" method="COI~lNECT”

</object>

To specify a particular port, add the following to your obj . conf file:

Cobject ppath="<:oz1nect : //* : 1080"

- Apache Web Server 1.3.2 (Linux) with Proxy Support: The following

two lines must be included in the httpd.conf file:

Proxy Requests On

AllowCONNE:CT <port list> (NOTE: This feature is available only

on version 1.3.2 and greater.)

THE CERTIFICATE WIZARD

Aventail Connect supports client certificates and provides you with a certificate

wizard to help generate and process a certificate. You start the certificate wizard

through the Aventail Connect program group (via the Start button or Program

Manager).

The Certificate wizard can create certificates for clients and servers. In this case,

you are only interested in creating a client certificate. However, whether for client

or server, you will need to mn this wizard twice: Once to generate a Certificate

Signing Request (CSR) to submit to your Certificate Authority (CA); the second

time, to process the certificate file. If this is your first time in generating a certifi-

cate request, Aventail recommends that you complete the second step immedi-

ately after the first.

To generate the client key pair and Certificate Signing Request (CSR)

1. Select the certificate wizard from the Aventail Connect program group.
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2. In the Certificate Type dialog box, select the client certificate option, and
then click Next.

Certificate Type

 
3. Provide the requested information by following the prompts in the subsequent

dialog boxes.

4. In the Key Length dialog box, select the size of your key.

which key lengths your CA accepts prior to generating your key NOTE: Not all CA5 accept keys ierger than 512 bits. it is prudent to know
pair. For testing purposes use 512 bits.
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What sizefslrength of keys would you like to generate?

 
 

  
 
  

  

T.he key size or length directly impacts the strength of encryption
used. The lager the key size the stronger the encryption.
However, stronger encryption requires more processing power.

P 512 hits, low

17 TEE bits, medium

P “J24 bits. high

5. Once you have generated the random data, continue through the screen

prompts until the Congratulations! screen, where you will see the name and

path to the new certificate request.

Congratulations!

The certificate request and keys for v are now ready to he sent to
your certifying authority for processing. Your certificate authority
will contact d@b for additional information if needed.

The certificate request has been saved in:

C:\F'FtU[iFlr5rl'v‘l FILES‘.-5rVENT:t-JLWPNE:L|El~lT'~.Socks5EI1.req

Elnce you receive your new certiicate, use this wizard again to
process it. along with the newly created key lite, Socks5lJ1.keys.
This will "produce the certificate tile. The wizard will detect any
pending requests and guide you through the procedure. 
 

To submit the Certificate Signing Request (CSH)

1. You are now ready to submit the CSR (the * . req file) to your CA (usually

via e-mail).

Aventail works with many certificate servers and certification authorities. Com-

panies such as Verisign (www.verisign.com) issue both client and server
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certificates. The Ave ntail Web site (www.aventail.com) gives concise instruc-

tions (see "TechNotes") on how to use these programs with Aventail's certifi-

cate wizard. Aventail CSRs are generated in a standard PKCS #10 format.

The CA will create a certificate file and issue a trusted roots file.

2. On receipt, copy (or place) the trusted roots file into the same directory as the

configuration file, and the certificate file into the Aventail Connect directory.

To pr_'oces_s_tl_1e _CSR

1. Run the certificate wizard, again. The wizard will detect the pending requests.
Click Process.

Certificate Flequests Detected

"You have-2 pending certificate reguestls].

 
 
 It you have received a ccnfirrnaticn train your Certifying .-iuthcrity,

you may now complete your recpest and create a certificate lie.
This file can then be ueed by Aventail security products.  
 I "Would like to process an existing request cr generate a new

venues?‘

2. Follow the prompts on the following screens. You will be asked to paste or

load the certificate response infonnation in a window area. Click Next.
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Import Flesponse

Your Certifying Authority may have delivered your response in
-various forrns. Please provide the response information by
pasting into the area below or by loading the information from a
tile.

 

  

3. Provide the root certificate file name in the Root Certificate screen. The root

certificate is your "trusted" root file. Click Next.

Provide Hoot Certificate

Please specity the file that contains your Certifying .5‘-.uthoIily's
certificate iniomialion.

 
4. The Summary screen will identify the pathnames to your key file, and certifi-

cate.

Verify that the roots file is in the same directory as the configuration file and

that the certificate file is in the Aventail Connect directory.

You have successfully created a client certificate and key pair.
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EXAMPLE NETWORK CONFIGURATION

The following section describes the setup of Aventail Connect in an example net-

work configuration using the Aventail ExtraNet Server.

CONFIGURATION USING AVENTAIL EXTRANET SERVER

The following example network configurations show the Aventail ExtraNet

Sewer configured for a Mobile Extranet environment and a Partner Extranet

environment. This example emphasizes simplicity to facilitate easy adaptation to

real world network designs.

Internal Duialll Hana:
IIlIlIIul.I1I9b.culI l|I.l.I.']

Eueor rul nenuln Nun:
blohjdil lI}I.'I'I.IDD.III

leenlno Uur uvllle ear
agtrlaulc IF eadnuslnn

Example corporate Network Design uslug Mobile VPN

The design used in the example above consists of two individual Ethernet seg-

ments, one public and one private. The public segment is used to host anony-

mous services available to the general public. The public access is provided

through a router that is connected to the public Internet. The private segment is

used to house all of the corporation's private network resources and data to be

used only by internal company employees. The Aventail ExtraNet Server

depicted in this example is used to provide secure and monitored access to the

private LAN for mobile employees and partners. For security reasons the Aven-

tail ExtraNet Sewer is configured such that operating system routing is disabled.

Therefore, no direct network connections between the public LAN and the pri-

vate LAN can be created without being securely proxied through the Aventail
ExtraNet Server.

The mobile user workstations connected to the public lntemet are the client

workstations, onto which, Aventail Connect will be deployed. Due to the routing

restrictions described above, these clients will have no network access beyond

the Aventail ExtraNet Server unless they are running Aventail Connect. Depend-

ing on the security policy and the Aventail ExtraNet Server configuration, Aven-

tail Connect will automatically proxy their allowed application traffic into the
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private network. In this situation, Aventail Connect will forward traffic destined for

the private internal network to the Aventail ExtraNet Server. Then, based on the

security policy, the Aventail ExtraNet Sewer will proxy mobile user traffic into the

private network but only to those resources allowed. The client workstations we
focus on in this section are Microsoft Windows based PCs.

The Aventail ExtraNet Server in our example, has two network adapters config-
ured to use the internal lP address of 10.1.1.1 and an external address of

129.79.100.64.

CAUTION: Since the internai network address space is part of the

M NA reserved address space (per BOP RFC 1918)

routing MUST be disabled on this host and routing
advertisements tor this internai network MUST NOT be

propagated to the outside worid.

User authentication and encryption on the Aventail ExtraNet Server require all

users to use Aventail Connect to authenticate and encrypt their sessions before

any connection to the internal private network(s). For this example, the Aventail

ExtraNet Server encrypts all sessions with SSL.

SEE ALSO: For additionai information on how to configure the

Aventail‘ ExtraNet Server product, consult the Aventail
ExtraNet Server Administrator’s Guide.

Installing and using Aventail Connect for remote access purposes differs a bit

from its installation and use within a corporate network. First, oonfiguration files

need to be kept locally on the workstation or laptop. This is due to the inability to

share a file server that allows direct access outside the perimeter of the private

network. Second, not all traffic passes through to the Aventail ExtraNet Server.

Only traffic destined for the internal network is authenticated and encrypted; all

other traffic passes through Aventail Connect unchanged. For instance, brows-

ing the Internet from the mobile user workstation occurs as if Aventail Connect is

not even running in the background. Large sites with many mobile users will

want to set up an internal file server for a network installation for all mobile users

to easily install and configure Aventail Connect. For more information, refer to
"Network Installation."
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| Utilities Reference Guide |

This section explains:

- Commands on the System menu, including Close, Hide Icon (in Win-

dows 3.1, Windows for Workgroups 3.11, and Windows NT 3.51), Help,

About, Credentials, and Configuration File

- How to use the Aventail Connect utilities, including the Config Tool, the

Logging Tool, and S5 Ping, all displayed through the Utility Programs
menu.

- How to use Secure Extranet Explorer (SEE)iExtranet Neighborhood.

SYSTEM MENU COMMANDS

Even though Aventail Connect requires little to no interaction with the user, there

are commands on the Aventail Connect System menu. To display the System

menu, right—click the Aventail Connect icon in the system tray on the taskbar

(Windows 95, Windows 98, and Windows NT 4.0) or click the minimized Aven-

tail Connect icon (Windows 3.1, Windows for Workgroups 3.11, or Windows NT

3.51).

Aventail Connect System Menu Commands

Closes Aventail Connect.

Hides the Aventail Connect icon from view. Not available in

Windows 95, Windows 98. and Windows NT 4.0.

Accesses Help.Help

Credentials Displays authentication credentials.

Each of the commands is discussed below.

 
CLOSE

This command closes Aventail Connect. Exiting Aventail Connect may limit

access to certain remote hosts or prevent you from using certain Winsock appli-
cations.
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HIDE ICON

This command hides the Aventail Connect icon from view (Windows 3.1, Win-

dows for Workgroups 3.11, and Windows NT 3.51 only). Aventail Connect will

run in the background. The Hide Icon command is not avaiiable in Windows .95,

Windows 98, and Windows NT 4.0.

HELP

This command accesses Aventail Connect Help.

ABOUT

This command displays the Aventail Connect About box. which includes Aven-

tail Connect software copyright notification, version information, and so on.

Clicking More displays a list of files used by the current version of Aventail Con-
nect.

CREDENTIALS

This command displays the Manage Credentials dialog box. Credentials

include the information (such as usernameipassword) that you enter when

establishing a connection to an extranet (SOCKS) sewer requiring user authen-

tication. (Aventail Connect prompts you with an authentication dialog box.) As

long as your credentials are in memory, you can establish connections to associ-

ated extranet servers without needing to reenter your authentication information.

You cannot edit credential data fields; you can, however, delete individual cre-

dential entries. Aventail Connect will prompt you to enter updated authentication

information when you reestablish a connection to the associated extranet server.

Manage Credentials E

SUCKS ‘Sewer

  .s"-',|_l T H | N FIII
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___—__- NOTE: You cannot edit the “AUTHiNFO” entries in the Manage Creden-
“"'* tiais dialog box. This information is for diagnostic purposes only.

SOCKS Server Extranet (SOCKS) server name.

User Name User name for the extranet server.

Method Authentication method.
 
To delete a credential entry

Delete authentication credentials when they are no longer correct. After the cre-

dentials are deleted, you will be prompted to reenter them the next time you con»
nect to the associated extranet server.

' Select the credential entry you want to delete and click Delete.

This deletes the credential information.

To exit the Manage Credentials dialog box

' Click OK to accept changes to the credentials and close the dialog box.

.012.

' Click Cancel to close the dialog box without accepting any changes you

might have entered.

—_ NOTE: Clicking Apply saves changes but keeps the dialog box open so

you can keep working.

CONFIGURATION FILE

This command lets you load a different configuration file via the Aventail Con-

nect Startup Options dialog box.
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 Connect Starlup Options

I 5 Please choose a configuration file to use with- Bormect CancelLLH
lkkthventailkcommonkconfig filecld -vl flrowse...

|_ Erompt at startup to determine the Connect configuration file.

F flulorn-atlcally alert with the .'n-inst Ier_::'3r.l. -.3l'.c«iu:e afiei ll‘: 2
§‘=3.-

 

For more information about the configuration file, refer to "Creating Configuration
Files."

To load a configuration file

Check with your network administrator before making any changes to the config-
uration.

' Select the configuration file you want to load (use the Browse button), and
then click OK.

' If you want Aventail Connect to start automatically with your most recent

choice of configuration file, select the Automatically start... check box, and

then select the start delay (in seconds).

The new configuration file transparently loads into Aventail Connect. You

can close and restart Aventail Connect for your change to take effect, or

wait the specified length of time if you selected the Automatically start...
checkbox.

UTILITIES

To display the Utility Programs menu, right-click the Aventail Connect icon in

the system tray on the taskbar (Windows 95, Windows 98, or Windows NT 4.0)

or click the minimized Aventail Connect icon (Windows 3.1, Windows for Work-

groups 3.11, or Windows NT 3.51).

Aventail Connect Utility Program Menu Commands.

Config Tool Runs the Config Tool. (Optional)

Logging Tool Runs the Logging Tool. (Optional)

S5 Ping Runs the ping and traceroute utilities. (Optional)

Each of the commands is discussed below.
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optionat components and witt oniy appear when the network

administrator has inctuded them in a custom setup package.

They are discussed in the sections “Contig Toot,” "Logging Toot,"

and "85 Ping.”

!__—_- H NOTE: The Contig Toot, Logging Toot, and S5 Ping commands are

CONFIG TooL

The Aventail Connect Config Tool creates configuration files that determine how

network requests will be routed and which authentication protocols will be

enabled. (This option may not be avaitabte to att users it the network administra-

tor has chosen not to instait it.)

 
 

 -E5 Ennlig Tool - [I:\___'U5nrenlai|'\AVenlaiI_clg

Elle flelp

Local Home Ft esolulion I Advanced I Authentication I
........... ..fi.......:.........:........fifl[éE............%| I I

 SEIIZKS Sewer

 
Network administrators generally create configuration files during Aventaii Con-

nect installation. However, you can add, remove, or modify configuration files at

any time. If necessary, you can create several configuration files for different

users or user groups. Some configuration files may reside on a networked drive,

accessible by multiple users. Other configuration files may be tailored to a spe-

cific user on an individual workstation. "Creating Configuration Files” discusses

the Config Tool in detail.

LOGGING TooL

The Logging Tool is an optional diagnostic utility for tracing Aventail Connect and

WinSock activity. When running a trace, the Logging Tool displays errors, warn-

ings, and information as Aventail Connect generates them. You can save the

message list to a log file that Aventail Technical Support can use in troubleshoot-

ing technical problems, including Aventail Connect network, extranet (SOCKS)

server, and Winsock application interoperability problems. Aventail Technical

Support engineers may request that you perform a verbose trace, log it to a file,
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and e-mail it to them as an attachment. Log files are also useful when running

Aventail Connect for the first time, to ensure that network traffic is being routed

propedy.

To trace Aventail Connect activity

1. Windows 95, Windows 98, or Windows NT 4.0: Either right—click the Aventail

Connect icon (in the system tray on the taskbar) and click Logging Tool, or

select Startl Programsl Aventail Connectl Logging Tool.

_oR_

Windows 3.1, Windows for Workgroups 3.11, or Windows NT 3.51: From the

Aventail Connect program group, double—click the Logging Tool program
icon.

 
 
 
 
 

 
 

  

4; Logging Tool

L09 Edi ‘flew liab-

llnfnrmetion

1 Date

1 2:0 3:93  6 ffla4e81 Running on Win9,__
 O ftla-Ile81 Redirecting cunn,.. "_' 12188198

0 fflae319 CCM:.Authentit:ati_,, 12183193 11118224
0 ffia-IIe81 Redirecting conn_._ 12183193 11188225
0 fflae319 (201.1: Authenticati___ 12:03:00 11:00:25
0 fl‘la4e81 Redirecting cunn... 12188198 11:88:28

0 ffla-!le81 Redirecting conn,,_ 12188198 11:88:29
0 fflae319 CCM:Authenticati___ 12183198 11188229
0 11186319 C(2M:Authenticati___ 12183193 11:08:29
® ffla-IIe81 Neisocketrevcvi]... 12:03:00 11:00:39
® ffla-!le81 Netsncket fBVI.':'Vfl_,_ 12188198 11:88:39
0 fflaIIe81 Redirecting conn,,_ 12188198 11:88:39 _I
For!-ielp,pressF1

2. In the Log menu, click Level and select one of the five levels of information

you want to trace.

_oR_

Select one of the five levels from the drop—down list on the toolbar.
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Fatal Errors Fatal errors only

Errors Errors and fatal errors only

Warnings Errors and warnings only

Information Errors, warning. and information

Verbose All of the above. and more descriptive information on progress of
connections

 
3. On the Log menu, click Trace.

-OR-

Click the Trace On button on the toolbar (shown below).

L-.og Edit Eiew fleip

K -‘"'::"':‘; I -
III" Efl

 
Enalnle logging

The log window will now record and display trace information as it is generated

by Aventail Connect. You can tell when the trace function is active because mes-

sages are scrolling down the screen and the Trace On button is depressed.

4. When you are ready to stop the Trace function, click Trace on the Log menu.

.012.

Click the Trace Off button on the toolbar (shown below).
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- 4, Logging Tool

LOB ..Edit Ifiietl‘ .."l8.lI=

FIT: | ,i~.1|e| ,ox|ss| atlwl

  
D isable logging

The Trace function stops. You can now scroll through the results, print them,
andlor save them to a file.

To save a log file

The Logging Tool allows you to append each new message to the end of a . LOG

file during the trace, or save the contents of the log window at any time. If you

save during a trace, Aventail Connect will append messages to the log file until

you stop the log function. You must save data in the log window to retain it.

You cannot open a preexisting log file from within the log window. To open a pre-

existing log file, you must open it in a text editor such as Notepad.

1. To save a log file as the data is being generated, click Log to File on the Log

menu. Enter the filename in the Select Log File dialog box.

_('_)R_

Click the File Logging button on the toolbar (shown below).
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- 4, Logging Tool

Lug ..E_dil ilrliéw ..|'l'8.lI=

a alaaiam
_

  
Lag diIBl::tly lo a file

2. Enter the filename in the Select Log File dialog box.

- To save the contents of the log window at any time, click Save As on

the Log menu and then enter the filename.

To filter messages in the log window

You can filter the contents of a log window by selecting the types of messages

you want to view. By selecting a specific type of message, you can easily scan

the information on-screen. If you save data to a log file, a View filter will not affect

the file contents; it merely adjusts the screen display of those contents.

1. On the View menu, click Filter Messages to display the Filter dialog box

.05».

Click the Filter button on the toolbar (shown below) to display the Filter dialog
box.
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,_‘-,.- Lagging TIJDI

NOTE: The Filter function is an on/off toggle. if the filter is enabied,

seiect Filter Messages to turn it off, then seiect it again to dis-

piay the Filter dieiog box.

I_'—

1 Filter
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Dem"

Categories Select any of the five filters to display errors. fatal errors, warnings,

information andlor verbose information in the log window.

Log Type I Select the type: of log to be filtered. (Currently. the only valid log
type used in Aventail Connect is Miscellaneous.)

Application 32-bit Show messages from 32-bit applications.

Type’
16-bit Show messages from 16-bit applications.

*These options are disabled if you are running 16-bit Windows.

2. Under "Categories," select one or more of the five filter check boxes. The log

window will adjust the display based on your selection(s).

3. Under “Log Type,” select the log type to filter.

4. Under "Application Type." select one or both of the check boxes.

To change the View parameters

The display font and window options can be customized as follows:

' On the View menu, click Font. Enter your font preferences into the standard

Windows Font dialog box.

' To display or hide the toolbar and status bar, click Toolbar andfor Status
Bar on the View menu.

To copy the log window

You can copy the log window contents to the Windows Clipboard.

' To copy all of the log window contents to the Windows Clipboard, click

Select All on the Edit menu. Then click Copy on the Edit menu, or click the

Copy button on the toolbar.

' To copy selected messages to the Windows Clipboard, drag the mouse over

the messages to highlight them. Then select Copy on the Edit menu or click

the Copy button on the toolbar.
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- 4, Logging Tool

LOB ..Edit 3£i8'-it‘ .."l6iI=

Copy the selection and put it on the Clipboard

 
To print the log window

You can print the contents of the log window can be printed only in its entirety.

' On the Log menu, click Print.

_oR_

Click the Print button on the toolbar.

The entire contents of the window will print, regardless of whether you

have specific messages selected. If you have filtered the display, only the

filtered messages will print.

To find a specific message

The Find command will only work with data displayed in the window. If the dis-

play has been filtered, only the filtered messages will be searched. The Find dia-

log box remains active until you close it.

' On the Edit menu, click Find.

_oR_

Click the Find button on the toolbar.

Then enter your search parameters in the Find dialog box.

To clear the log window

Clear the log window contents when you are ready to execute a new trace.

' On the Edit menu, click Clear All.

_oR_
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Click the Clear All button on the toolbar.

To close the log window

When you are ready to close the log window, make sure you have saved the

contents of the trace for later reference. All settings are saved when you exit.

' On the File menu, click Exit.

S5 PING

Two of the most useful diagnostic tools in an administrator's arsenal are the ping
and traceroute utilities.

- The ping utility checks for network connectivity between two hosts and

returns information about the quality of the connection.

- The traceroute utility checks for network connectivity by displaying

information about routers between two hosts. It displays information for

each hop.

Ping and traceroute both use Internet Control Message Protocol (ICMP).

SOCKS v5 is designed to handle TCP and UDP protocols; however, SOCKS v5

does not support ICM P. Because ping and traceroute are based on ICMP, there

is no way to directly proxy a ping or traceroute request. To circumvent this prob-

lem, Aventail Connect provides a utility called 85 Ping.

S5 Ping determines whether a host outside of an extranet server is active. After

a response from the host returns, the extranet server relays the data back to the

client and displays it in the S5 Ping dialog box.

To launch S5 Ping

You can use S5 Ping whether or not Aventail Connect is running. However, if the

server that you are connecting through requires authentication, you must load

Aventail Connect before reconnecting.

- Windows 95, Windows 98, or Windows NT 4.0: Select Start i Programs I

Aventail Connect I 85 Ping.

_oR_

Windows 3.1, Windows for Workgroups 3.11, or Windows NT 3.51: From

the Aventail Connect program group. double—click the S5 Ping program
icon.

_OR_

If Aventail Connect is already running, right-click the Aventail Connect

icon on the taskbar and click S5 Ping (Windows 95, Windows 98, or Win-

dows NT 4.0), click the minimized Aventail Connect icon in the System

menu (Windows 3.1, Windows for Workgroups 3.11, or Windows NT 3.51 ).

The S5 Ping dialog box appears.
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NOTE: 85 Ping will function without a property configured Aventaii Con-

nect; however, the user wiii be required to type the information

about the target extranet server and target host into the SOCKS
Server and Destination boxes.

 

Operation Select ping or traceroute.

SOCKS Server The Extranet (SOCKS) server that will execute the

operation. If Aventail Connect is already configured, this list

will be preloaded with extranet sewers from the

configuration file.

Destination The extranet sewer you want to ping (or traceroute). If

Aventail Connect is already configured, this list will be

preloaded with single host destinations defined in the

configuration file. (See "Configuring Aventail Connect.”)

The results of successfui connection. The format of the

results will vary based upon the extranet server platform.

 
S5 Ping can be used whether or not Aventail Connect is running. However, if the

server that you are connecting through requires authentication, you must load
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Aventail Connect before connecting. The network administrator may or may not

make 85 Ping available to users during installation. In some cases, the S5 Ping

command will not appear on the Aventail Connect System menu or in the pro-

gram group.

Once the S5 Ping dialog box opens, you can execute a ping or traceroute net-

work operation.

To run ping or traceroute using S5 Ping

S5 Ping has two modes of operation: ping and traceroute.

1. Under "Operation," select one of the two options, Ping or Traceroute.

2. Under "SOCKS Server," select an Aventail ExtraNet Server to carry out the

operation. If no sewers are listed (because S5 Ping did not locate an Aventail

Connect configuration file), type the extranet server's hostname or IP
address.

3. Under "Destination," select a single host destination to ping or traceroute. If

no hosts are listed (because 85 Ping did not locate an Aventail Connect con-

figuration file). type the hostname or IP address of the host you want to ping
or traceroute.

4. Click Start to execute the operation. Start then changes to Stop. Results

from any previous operation are cleared from the window.

5. If the extranet server requires authentication, you may be prompted with a

server certificate or required to enter a username and password. (For more

information about server certificates and usernarnelpassword authentication,

see "Manage Authentication Modules" in the Admr'm'strator’s Guide.)

6. Once the connection to the host has been made, the information returned

from the server will be displayed in the Results window.

To stop ping or traceroute

' Click Stop.

This stops the operation and changes Stop to Start. The results of the

operation remain displayed in the S5 Ping dialog box.

To exit 55 Ping

" Click Exit.

This clears the results and closes the S5 Ping dialog box.
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SECURE EXTRANET EXPLORER

Secure Extranet Explorer (SEE) allows you to view your Extranet Neighborhood,

which is accessed through the Extranet Neighborhood icon on your desktop.

The Extranet Neighborhood user interface resembles that of Network Neighbor-

hood. However, while Network Neighborhood displays all computers on your

local network, Extranet Neighborhood allows you to browse, copy. move, and

delete files from remote computers via the Aventail Connect extranet connec-

tion. With Extranet Neighborhood, all interaction with the remote server can be

secured. Network administrators determine which local and remote computers
are available to users.

NOTE: Some installations of A1/entail Connect may not include SEE.
Network administrators can decide whether or not to include SEE

in a custom setup package.
 

Extranet Neighborhood, a Windows Explorer shell extension, is a collection of

Windows file servers and Windows NT domains. Network Neighborhood dis-

plays only those remote computers that the network administrator has specified.

SEE requires a hosts file (SEEHosts) that determines which Windows file serv-
ers and NT domains are available. You can include a SEEHosts file with the

Aventail Customizer tool. If users install a custom package that does not include

a SEEHosts file, then the first time they open Extranet Neighborhood, SEE will

create a SEEHosts file. For more information, see the “Customizer" section in
the Administrator’s Guide.

Extra net Neighborhood offers Aventail Connect users a secure alternative to tra-

ditional file-browsing methods. Users can securely access computers from the

desktop through Extranet Neighborhood (see icon below). or through Windows

Explorer.

IE1igi‘IiZIIIIli'|I£IDd 
Generally, you will use Extranet Neighborhood to connect to a remote network

through Aventail Connect. For example, you will use Extranet Neighborhood
when:

- you are inside the office, on the corporate network, and you connect

through an Aventail ExtraNet Sewer to your company’s remote site, or

to another company's network.

- you are outside the office, and you connect your laptop through an

Aventail ExtraNet Server to your internal company network, or to

another company’s network.
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NOTE: To use Extranet Neighborhood with remote hosts, Aventaii Corr

neol‘ must be running and configured correctly. 

HOW EXTRANET NEIGHBORHOOD WORKS

Typically, with Windows networking, the Microsoft Windows Explorer and Net—

work Neighborhood browse files using NetBl0S (NBT), over TCP. Network

Neighborhood does not use the standard WinSock programming interface. This

prevents Aventail Connect from redirecting TCP connections. Since Ave ntail

Connect redirects only WinSock calls, it cannot redirect NBT calls.

To deliver a secured version of standard Windows browsing, Aventail Connect
redirects NBT calls to WinSock. This allows Aventail Connect to redirect this traf-

fic based on a set of redirection rules. as defined in the Aventail Connect config-
uration file.

Extranet Neighborhood can use either hosts files or Windows Internet Naming

Service (WINS) servers to map a computer's Internet (host) name to its Win—

dows machine name. Without a hosts file or a WINS server, Extranet Neighbor-

hood cannot associate a computer's Internet name with its Windows machine
name.

Extranet Neighborhood includes a browsing mode, which allows you to view a

dynamic list of available Windows hosts. Hosts files provide a static list of hosts.

There are two basic methods for configuring Extranet Neighborhood.

- Listing WINS Servers: List only WINS servers for the domain(s) in the
hosts file. You do not need to list individual hosts within the domain.

- Listing Individual Hosts: List every individual host in the hosts file that
will be accessible to users.

LISTING WINS Senvens

To use Extranet Neighborhood in the browsing mode, you must configure Extra-

net Neighborhood to use WINS, and you must identify the IP address (host-

name) of the WINS server(s) and, possibly, the primary domain controller (PDC)

for the domain. If you do not specify a WINS server, you will not be able to use

Extranet Neighborhood in the browsing mode.

The PDC for the domain is required only if the destination network is not acces-

sible by UDP. (For example, when using MuItiProxy, the destination network is

not UDP-accessible.) When Extranet Neighborhood is in browsing mode, it must
be able to resolve the name of the host. If the destination network is UDP-acces-

sible, then the WINS server is used to map a computer's Internet (host) name to

its Windows machine name. If the destination network is not UDP-accessible,

then Extranet Neighborhood uses the PDC and DNS to determine the host’s
address.
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LISTING INDIvIDuAL HOSTS

To use Extranet Neighborhood in the static host list mode, you must define, in

the hosts file. each individual host in the domain. This allows you to restrict

access to designated hosts only. In the hosts file, you must specify the host's IP

address or DNS name along with the Windows machine name. WINS and PDC
are not used in this method.

INSTALLING EXTRANET NEIGHBORHOOD

When installed, Extranet Neighborhood appears on your desktop as an icon,

and in Windows Explorer. You can open, move, copy, and delete files in Extranet

Neighborhood just as you would in Network Neighborhood.

If you need to install Extranet Neighborhood, install it from the Aventail Connect

CD. Or, if you downloaded your copy of Aventail Connect, run the downloaded

executable package. When the Installation Components and Sub-compo-

nents dialog box appears, select Extranet Neighborhood (located under Com-

ponents). Continue with the installation process.

The default installation directory is

\Program Files\Aventail\Connect.

NOTE: Secure Extranet Expiorer/Extranet Neighborhood is available

oniy on Windows 95, Windows 98, and Windows NT 4.0 operat-

ing systems.
 

CONFIGURING EXTRANET NEIGHBORHOOD

You can include a SEEHosts file with the Aventail Customizer tool. Only by

installing a custom package will users have a local or remote hosts file

automatically configured. if users install a custom package that does not include

a SEEHosts file, the SEE Configuration wizard will run when users open

Extranet Neighborhood for the first time. The SEE Configuration wizard walks

you through the process of defining local or remote hosts files. Aventail

recommends that you use the Customizer tool to distribute Extranet

Neighborhood, bundled with a hosts file, in a custom setup package.

Extranet Neighborhood can automatically construct a hosts file from your local

network or a remote network. Using the Search feature, Extranet Neighborhood

can automatically “browse" available computers and build the local hosts file.

The Search feature is available through the Extranet Neighborhood Proper-

ties I Local tab. Alternatively, you can enter the names of the available comput-

ers manually. The Search feature browses only those computers that are within

your internal network. To search remote networks, you must manually enter the

fully qualified hostname of each remote WINS server that is outside your Aven-

tail ExtraNet Server. when using the Search feature. the same UDP restrictions

described in “Listing WINS Servers" apply.
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NOTE: To use the Search feature, Aventaii Connect must be running and

contigured correctly. 
Do not use the Search feature if you are using the WINS-browsing mode. The

Search feature builds the local hosts file for all of the oomputers, which is not

necessary with WINS. Use Search when creating a local hosts file using the “list-

ing individual hosts" method.

NOTE: When you click Search, you may see more than one domain in

the resuiting iocai hosts tite. This is because Search inciudes
trusted domains.

 
To create a hosts file

Use this procedure if you have not yet created a hosts file.

1. Decide which method, listing WINS sewers or listing all individual hosts, to
use.

2. If no hosts file exists, launch Extranet Neighborhood (Extranet Neighborhood

will prompt you automatically if you are running Extranet Neighborhood for the

first time),

-QR-

Right-click the Extranet Neighborhood icon on your desktop and then click

Properties.

3. Follow the on-screen instructions to create the hosts file.

4. To distribute the new hosts file, include the SEEHosts file in your custom

setup package, if using the Customizer tool.

After creating the hosts file, users can browse only those domains and machines

that the network administrator has included in that list of hosts. This list may be a

local hosts file called “SEEHosts" andior a remote host list, which is identified by

[share] \ [path] \ [ filename] .

NOTE: To use the browsing mode, you must specify the domain ’s WW8

sen/er(s) in the iocai hosts tiie.

CAUTtON: SEE cannot recognize share names that contain speciai

characters (e.g., e) or muitipte spaces (e. g., Aventail

Custom Computer). SEE aiso wiii not recognize hidden

one-letter share names (e.g., C$ or DS).
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SEE CONFIGURATION METHODS

There are numerous methods for configuring SEE. The three most common
methods are described below.

Local Hosts File Method

With this method, the hosts file contains a list of all domains and servers in the

local hosts file. Every host is listed.

There are two ways to configure SEE using this method.

- In the Extranet Neighborhood Properties I Local tab, manually add
each domain and host to the local hosts file

_oR_

- On the Local tab, click Search, click Search Local Network, and then

search any remote networks, if necessary. SEE automatically builds a

list of all hosts. You may delete hosts from the local hosts file if you do
not want users to view them.

NOTE: To view your domains, double—ciick the Extranet Neighborhood

icon on your desktop. it you make changes to the hosts file, you

can reload the Extranet Neighborhood domains window by

pressing the F5 key.

 

Remote Hosts File Method

With this method, the local hosts file contains the path of the remote hosts file,

and the remote hosts file contents are determined by which configuration

method you use.

To use this method, first create the remote hosts file, and then create a local

hosts file that points to the remote hosts file.

To configure SEE using the remote hosts file method

1. Create a local hosts file, using one of the methods listed above, and copy it to

a central location. (This creates a remote hosts file; this file is not distributed

with Aventail Connect.)

2. On the Remote tab. click Add, and then add a pointer to the remote hosts file

that you created in Step 1. (This file is distributed with Aventail Connect.)

NOTE: You can point to multipie remote hosts files on a singie iist.

 
wms Browsing Method

With this method, the hosts file contains a list ofall domains, and the WINS serv-

ers for each domain. You do not need to list all of the computers.
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To use this method, add each domain in the Local tab, specifying the primary

WINS server and. if applicable, the secondary WINS server, and then select the

Make domain browsable check box in the Windows Domain dialog box.

Choosing a Method

Each of the three methods has advantages and disadvantages. The table below

lists pros and cons for each of the three methods.

Disadvantages

Local hosts

file with

individual

computers

The administrator

controls exactly
which hosts the users

can see. On slower

connections, this
method is fastest

since you do not
need to send a list of

sewers to the client.

The administrator must update the local
hosts file if file servers are added to or

removed from the domains.

Remote hosts

file
° The administrator

can edit the centrally
stored hosts file

whenever necessary.

' lf the hosts file is

stored behind a

firewall, SEE can go

through an extranet

server (using

encryption and

authentication) to
reach it.

° Users are immediately prompted to

enter authentication credentials upon

opening SEE (because SEE must load

the remote hosts file).

' If a user loses network connectivity to

the hosts file, SEE will not display the list

of hostslcom puters.

Local hosts

file with WINS

browsing

The administrator

does not need to

update the hosts file

if new computers are
added or removed.

You are not limited to using only one method for configuring SEE. You can use a

' The administrator must update the local
hosts file if domains are added or

removed.

' The administrator cannot control which

computers appear in SEE; all computers

in the NT domain are displayed.

' On slower connections, this method is

slower than other methods because a list

of computers must be sent to the client.

combination of the various methods. For example:

- Use WINS browsing for some domains, and explicitly list hosts for other
domains

..QR..

- Use multiple remote hosts files
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-0R-

- Specify some computers in a local hosts file and others in a remote
hosts file.

SEE PROPERTIES

To access information about the current configuration of SEE, or to make

changes to that configuration, right-ciick the Extranet Neighborhood icon and

click Properties, or click View I Options in any open SEE window. The Extra-

net Neighborhood Properties window will appear with the General tab
selected.

THE GENERAL TAB

The General tab displays information about the current configuration of SEE.

Extranel Neighborhood Properties

THE LOCAL TAB

The Local tab displays the computers that are listed in the local hosts file.
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Extranel Neighborhood Properties

 

AVEN TAIL [not browsable]
BCI B KA [not browseblel

TES T [not browsable]

T HUSTDDMAIN [not browsable]

WUFIKEFIUUF‘ [not browsable]

 
Add Domain I Add Hget I Edit I

Qelele I fieaich... I flelp I

 
If you have specified a host in the local hosts file, you can add, edit, or remove

computers or domains that appear in the Local tab. If you have specified hosts

in the remote hosts file, they will not appear in this tab. To edit hosts in the

remote hosts file, you must copy the file to your Aventail Connect directory. edit

it, and then replace it in the remote hosts directory.

If you are using the WINS browsing mode, the individual computer names will

not appear. Any hosts specified in remote hosts files, including WINS servers,

will not appear in this tab.

The Add Host and Add Domain buttons allow you to add additional computers

or domains in the Add Host to Aventail dialog box and the Windows Domain

dialog box.

If no computers or domains appear in your Local tab, check the Remote tab. It

is possible that your network administrator has configured Extranet Neighbor-

hood with only a remote hosts file.

The Search feature can automatically browse available computers in local or

remote domains and populate your local hosts file. Alternatively, you can enter

the names of the hosts files manually.
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NOTE: To view your domains, double-ciick the Extranet Neighborhood

icon on your desktop. To reioad the hosts tiles in the Extranet

Neighborhood domains window, press the F5 key.

NOTE: in the Local tab, “browsabie” domains do not show individuai

computers in them.

 
Hosts File Locking

If the controls in this window are disabled (dimmed), then the hosts file has been

"locked." The network administrator determines which. if any. hosts files are
locked.

You can lock and unlock files from any Extranet Neighborhood Properties tab.

- To look a file, use the Ctr|+L command.

- To unlock a file, use the Ctrl+U command.

Windows Domain Dialog Box

To open the Windows Domain dialog box, click Add Domain in the Extranet

Neighborhood Properties I Local tab.

Windows Domain E

Domain Name: ii EIK

Comment: I Cancel |

I. Make domain browsable Help I

- Browsable Domain

Primary WIN 3 Server: I

Secondary WI NS 5 ewer: |

Primary Domain Controller: i

Note: The Primary Domain Controller is required only if the destination network is
not accessible using UDP.

 

For each domain, you can either specify the WINS server names or specify each

individual host that should appear in the domain. Listing WINS servers will result

in a smaller, more manageable hosts file. You must add a domain before you
can add hosts to that domain.
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To make the specified domain “browsable," enter WINS server information in the

Primary WINS Server box and. if desired. the Secondary WINS Server box. In

both of these boxes, you can enter either the server's IP address or its fully qual-
ified host name. You must also select the Make domain browsable check box.

If you do not select the Make domain browsable check box. Extranet Neighbor-

hood will display only those computers in the local or remote hosts file, even if

you have specified a WINS server.

NOTE: To use the browsing mode for a domain, you must specify the

domain ’s WiNS serve-r(s) in the hosts file. You must specify the

WiNS server(s) oniy it you want to use the browsing mode.
 

To view your domains, double-click the Extranet Neighborhood icon on your

desktop. To reload the hosts files in this screen, press the F5 key.

Add Host to Aventaii Diatog Box

To open the Add Host to Aventail dialog box, click Add Host on the Extranet

Neighborhood Properties I Local tab.

Add Host to AVENTAIL E

Windows 5 erver Name: .3 |.,;_

Cancel |H ost N arms or IP Address:

| Help |

D escriplion:

 

Aventail Connect automatically places hosts within the domain that is selected

when you click Add Host. Select the correct domain before clicking Add Host.

You must specify a domain before you can add hosts to that domain.

In the Host name or IP address box, be sure to enter the server’s Internet

address, not its Windows machine name.

THE REMOTE TAB

If the network administrator has configured Extranet Neighborhood to use a

remote hosts file, this tab displays the information about the currently configured

remote hosts fi|e(s). Sewer name, host name or address, pathname, and user-

name are all configurable through the Remote tab.
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Extranel Neighborhood Properties

Eenerall Local Flemote I

The following remote host files are current-ty being used You may
add and remove entries from the Isl.

Remote hosts files are always used in conjunction with a local hosts file. When

you add a remote hosts file to the list. Extranet Neighborhood adds the path to

the local hosts file. Extranet Neighborhood always has a single local hosts file;

this file can include references to multiple remote hosts files.

The most common configuration is one remote hosts file (with all domains and

hosts in the remote hosts file) and one local hosts file that contains a pointer to

the remote hosts file. If you want users to share a common hosts file, and if you

want to simplify administration, use a remote hosts file.

To add entries to the list of remote hosts files, click Add. The Remote Hosts File

dialog box appears, and you can type the names of the remote hosts fi|e(s) you
want to add.

NOTE: To access remote hosts files, Aventaii Connect must be running

and configured correctly. 
Remote Hosts File Dialog Box

To open the Remote Hosts File dialog box, click Add on the Remote tab.
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UNE filename sf remote host Fir-.~

WSEB3fEH]\{SHAfiE]\'[BiH]\[FiLE;1

 
Windows domain or workgoup of server:

Host name or IP address of sewer:

 

When entering the Universal Naming Convention (UNC) fiiename of the remote

hosts file that you are adding, note that the [SERVER] name is the Windows
machine name, not its IP address or hostname.

In the Host name or IP address of Server box. be sure to enter the server’s

Internet address, not its Windows machine name.

NOTE: Extranet Neighborhood ignores any remote hosts files that it can-
not access. 
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Troubleshooting 

Aventail Connect-related problems tend to fall into four categories: Installation,

Network Connectivity, Configuration, and Application and TCPIIP Stack Interop-

erability.

AVENTAIL CONNECT INSTALLATION PROBLEMS

When the instructions in "Installing" in the Administrator’s Guide are followed,

Aventail Connect installation problems rarely occur. When they do occur, they
are often the result of:

- Toolbars, virus-checking utilities, or other Windows applications

running during the installation

If any of these are running during a failed installation, close them, unin-

stall Aventail Connect, reboot, and then re-install Aventail Connect,

ensuring that the toolbars, virus—checl<ing utilities, or applications are

not automatically restarted when the system reboots.

- Insufficient RAM or free space on the volume to which Aventail

Connect is being installed

If you suspect either of these as the cause of a failed installation,

increase the available resources and retry the installation.

- Corrupted Aventail Connect installation media, or corrupted or

incomplete FTP of Aventail Connect self-extracting, executable
installation file

If you suspect corrupted Aventail Connect installation diskettes as the

cause of a failed installation, contact Aventail Technical Support

(206.21 5.0078) for assistance in determining whether the files on the

diskettes may have been corrupted and whether Aventail or your ven-

dor must supply replacement diskettes.

If you suspect a corrupted or incomplete FTP transfer of Aventail Con-

nect installation files obtained over the Internet, retry the transfer, taking

care to ensure that the FTP client is in binary mode and confirm that the

transfer completes normally. Contact Aventail Technical Support to con—

firm that the byte size of the transferred installation file is correct.

- Installation to a workstation on which Aventail Connect was run-

ning or from which a previous version of Aventail Connect was not

completely uninstalled

If you suspect either of these circumstances as the cause of a failed

installation, contact Aventail Technical Support.
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- Installation script errors

Aventail Connect is installed with lnstallshield. If lnstallshield reports

errors during a failed installation, note the text of the error messages

and the specific circumstances in which they occurred and contact

Aventail Technical Support.

NETWORK CONNECTIVITY PROBLEMS

Before Aventail Connect can successfully redirect WinSock application connec-
tions:

1. The workstation on which Aventail Connect is installed must also have a prop-

erly installed, WinSock-compatible, TCPIIP stack running on it.

This installation can be confirmed by successfully pinging the IP address of

the workstation, from the workstation itself, using a WinSock ping application.

If this test fails, the failure must be corrected before Aventail Connect can be

tested and before Aventail Technical Support can provide assistance.

2. Basic TCPIIP network connectivity must exist between the client workstation

on which Aventail Connect is installed and the extranet (SOCKS) server(s) to

which it is configured to redirect connections.

This connectivity can be confirmed by successfully pinging the extranet

server(s) by IP address, from the client workstation. If this test fails, the failure
must be corrected before Aventail Connect can be tested and before Aventail

Technical Support can provide assistance.

3. Basic TCPIIP network connectivity must also exist between the extranet

server(s) and the network host(s) to which the extranet server(s) are expected

to proxy connections.

This connectivity can be confirmed by successfully pinging the network

host(s), by IP address, from the extranet server(s). if this test fails, the failure
must be corrected before Aventail Connect can be tested and before Aventail

Technical Support can provide assistance.

AVENTAIL CONNECT CONFIGURATION PROBLEMS

This section addresses troubleshooting of simple Aventail Connect configuration

problems. Troubleshooting complex Aventail Connect configuration problems is

beyond the scope of this section.

It is easiest to troubleshoot Aventail Connect configuration problems by creating

and testing simple Aventail Connect configuration files, such as those that may

be created with the Aventail Connect configuration wizard. However, all refer-

ences to host and domain names must be removed from configuration files cre-

ated with the wizard. before testing, to defer possible name resolution

complications until the files can be demonstrated to work with IP addresses
alone.
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Troubieshooting

NOTE: The IP address and SOCKS port number of the extranet

(SOCKS) server(s) to which Aventaii Connect must connect must

be known before troubleshooting Aventaii Connect configuration

problems. Neither Aventaii Connect, nor Aventait Technical‘ Sup-

port, can discover the IP address or port number of the extranet

server(s).

When troubleshooting Aventail Connect configuration problems, confirm that the

Aventail Connect configuration file that is currently selected in the Configura-

tion File dialog box is the one intended for testing.

After selecting a configuration file to test, open the Aventail Connect Config Tool
and:

1. Confirm that the extranet server has been correctly identified by IP address.

Click the Servers tab, select the server alias and then click Edit.... Compare
the IP address in the Hostname or IP box with that of the extranet server.

If the extranet server is a SOCKS v5 server, click SOCKS v4 in the “SOCKS

Version" area of the Sewers tab. Then click Detect Version. The selection

will revert to SOCKS V5, indicating that Aventail Connect detected a SOCKS

v5 server running at the IP address specified in the Hostname or IP box.

If, on the other hand, the extranet server is a SOCKS v4 server, click SOCKS
v5 in the “SOCKS Version" area. Then click Detect Version. The selection

will revert SOCKS V4, indicating that Aventail Connect detected a SOCKS V4

server running at the IP address specified in the Hostname or IP box.

If Detect Version fails to detect an extranet server of either version, it is pos-

sible that no extranet server is running on the host identified in the Hostname

or IP box. Contact your extranet server administrator to confirm that the extra-

net server is running at the address specified.

2. Confirm that all Aventail Connect authentication modules are enabled.

Click the Authentication tab and confirm that the “traffic light" icons for all of

the authentication Modules are green, indicating that the modules are

enabled. Enabling all the modules configures Aventail Connect to attempt any

tom of authentication demanded by the extranet server or null (no) authenti-

cation. Note the form of authentication demanded by the extranet server and,

if necessary, obtain the proper authentication credentials, such as an extranet

server username and password, from the extranet server administrator.

3. Confirm that the network hosts to which the extranet server is expected to

proxy connections are within a redirected destination.

Click the Destinations tab, select the destination that includes the network

host to which the extranet server is expected to proxy connections, and then
click Edit.... Confinn that the definition of the Destination includes the network

host.

Next, click the Redirection Rules tab. Confirm that connections to the Desti-

nation are configured to be redirected by the extranet server.
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After making any necessary changes to the Aventail Connect configuration,

restart Aventail Connect and then restart any WinSock applications before

testing the new configuration.

APPLICATION AND TCP/IP STACK INTEROPERABILITY

PROBLEMS

Aventail Connect is intended to “automatically socksify" all "well-behaved" Win-

Sock applications. Occasionally, you may find WinSock applications that Aven-

tail Connect does not socksify, clue to interoperability problems with the

application.

Aventail Connect is also intended to run on all Winsock-compliant Microsoft

Windows TCPIIP stacks. Aventail Connect does not alter or replace Winsock or

any other core TCPIIP components (files) provided by the operating system.

Occasionally, you may find WinSock stacks on which Aventail Connect does not

run as expected, due to interoperability problems with the stack.

If you suspect an application or stack interoperability problem, report it to Aven-

tail Technical Support. Aventail will make every reasonable effort to resolve

interoperability problems.

AVENTAIL CONNECT TRACE LOGGING

Aventail Connect includes a Logging Tool for tracing Aventail Connect and Win-

Sock activity. Aventail Connect traces are often useful in troubleshooting Aven-

tail Connect network, extranet server, and WinSock application interoperability

problems. Aventail Technical Support engineers may request that you perform a

verbose trace, log it to a file, and e-mail it to them as an attachment.

To run an Aventail Connect trace

1. Close any WinSock applications that are running on the workstation.

2. If Aventail Connect is running, close it and then restart it.

3. Start an Aventail Connect trace.

In Windows 95, Windows 98, and Windows NT 4.0, right-click the minimized

Aventail Connect icon in the system tray. and click Logging Tool. In Win-

dows 3.1, Windows for Workgroups 3.11, and Windows NT 3.51, double-click

the Logging Tool icon in the Aventail program group. The Aventail Connect

Logging Tool window will open, as illustrated in Figure 1, below.

4. On the Log menu, confirm that the Trace command is checked. If it is not,
click Trace to enable it.
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To save an Aventail Connect trace to a file

1. On the Log menu, confirm that the Log To File command is checked. If it is

not, click Log To File to enable it.

2. The Select Log File dialog box (shown below) appears. Enter a file name and
click Save.

Select Log File B E

Savejné: |®vPr~4c:iieni v| Eng
Co pyH ook

File name: 

Bat-‘E-aslvpe‘. |Log Files "I ca,-,ce| | 

ERROR MESSAGES

Occasionally, you may see an error message while running Aventail Connect.

The following table explains some of the more common Aventail Connect error

messages.

 
Setup has determined that your SETUP: To install Aventail Connect 3.01, you

computer does not have this must first install the Microsoft Winsock 2.0

support and needs the Winsock upgrade.

2.0 patch, available from
Microsoft.

The patch is available for SETUP: Location of the Microsoft Winsock 2.0

download on the Microsoft Web upgrade.

site, at www.microsoft.com!
windows/downloadsfcontentsl

Updates/W95Sockets2r'

detaultasp.

You must have administrator SETUP: On Windows NT machines. you must

privileges to install. have administrative privileges to install or uninstall
Aventail Connect.
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Setup has detected that a previous

installation of (....) is present.

Would you like to continue and

upgrade to (....)? Pressing NO will

leave your existing installation

intact and will cause Setup to
terminate.

SETUP: Retain the previous installation of

Aventail Connect by pressing NO. Replace with

the newer installation by pressing YES.

The package does not contain the

necessary 3.01 files. Please

contact your administrator.

The package does not contain the

necessary 2.51 files. Please

contact your administrator.

The file you have selected is not a

valid Aventail setup file. Would you
like to create it?

Customizer must be run from a

valid Customize directory. Your

changes will not be saved.

SETUP: Setup cannot find the necessary Aventail
Connect 3.01 files.

SETUP: Setup cannot find the necessary Aventail
Connect 2.51 tiles.

CUSTOMIZER: Create a new setup file, or retain a

previous setup file.

CUSTOMIZER: Must run Customizer from a valid

Customize directory.

The Connect executable does not

have a valid Aventail digital

signature.

The specified signature is not valid.

Connect cannot find your license

file, aventai|.a|f.

Aventail Connect cannot find a valid Aventail

license file, aventai|.a|f.

Connect cannot load because your
license file does not contain a

license.

The license file exists, but it contains no license.

This version of Connect does not

support H‘l‘l'P servers.

Aventail Connect 2.51 does not support HTTP
servers.

REPORTING AVENTAIL CONNECT PROBLEMS

Report Aventail Connect problems to Aventail Technical Support by completing

and submitting an Online Support form on the Support page of the Aventail Web

site, http:/fwww.aventai|.com.

Aventaii Connect 3.01/2.51 Admi'nr'stra1‘or’s Guide - 107

Petitioner Apple Inc. — Exhibit 1022, p. 208



Petitioner Apple Inc. - Exhibit 1022, p. 209

Glossary

Glossary

ALIAS

User-friendly name for destination network or host computer.

AUTHENTICATION

A method for identifying a user in order to establish access to a system

resource or network. Authentication information such as usernamelpassword

is entered via prompts.

CERTIFICATE

A certificate is essentially an electronic "statement" which verifies that a cer-

tain RSA public key is associated with a particular name. Certificates are

issued by a Certification Authority (CA).

CLIENT

A program or Internet service that sends commands to and receive informa-

tion from a corresponding program known as a server. Most Internet services

run as clientlserver programs.

CONFIGURATION FILE

A file of information containing traffic redirection rules used to determine if
and how SOCKS redirection should occur.

CREDENTIALS

Credentials include the information (such as usernamelpassword) that you

enter when establishing a connection to a SOCKS server requiring user
authentication.

DOMAIN

Internet name for a network or computer system.

ENCFIYPTION

A security procedure that converts data into a format which can be read only

by the intended recipient computer.

EXTRANET

A network that is partially accessible to outsiders.

FIHEWALL

Software or hardware barriers that control the flow of information to Private

networks.
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GATEWAY

A communications devicelprogram that passes data between networks.

HACKER

A person who enjoys using computers and has a thorough understanding of

how they work, as well as the networks they run on. Often used to mean

"cracker," the correct term for someone who accesses computer systems
without authorization.

HOST

A sewer connected to the Internet.

IETF

Internet Engineering Task Force: An open community of network designers,

vendors, etc. who resolve protocol and architectural issues for the quickly

evolving Internet.

INTERNET PnoTocoL (IP)

The basic data transfer protocol used for the Internet. information such as the

address of the sender and the recipient is inserted into an electronic "packet"
which is then transmitted.

INTRANET

A network that is internal to a company or organization.

LAN

Local area network

LAYERED SERVICE PROVIDER (LSP)

A program that is installed just below WinSock 2.0. allowing two-way commu~

nication between the WinSock 2.0-compatible application and the underlying

TCPIIP stack. An LSP can redirect andfor change data before sending the

data to the operating system's TCPl'iP stack for transport over the network.

LOG WINDOW

The window of the Logging Tool which shows alerts, messages. and warnings

generated by Aventail Connect.

PING

A utility that determines if a remote host computer is up. ping sends data

packets to the host. If the packets are not returned, the host is down.

PROTOCOL

Rules and procedures used to exchange information between networks and

computer systems.
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REDIRECTION RULES

Rules defined in the configuration file which specify how network requests are
routed to SOCKS servers.

ROUTER

A device that transmits traffic between networks

SERVER

A networked computer that shares resources with other computers. Sewers

“serve up" information to clients.

SMB

Server Message Block. A message format used by DOS and Windows for

sharing files, directories, and other resources.

SOCKS

SOCKS is a security protocol. It acts as a proxy mechanism that manages the

flow and security of data traffic to and from your local area network or intra-
net.

SSL

Security Sockets Layer. An authentication and encryption protocol.

TRACEROUTE

A utility that traces the routing of data Over the Internet to a specific computer.

Traceroute sends a data packet and then lists the intermediate host comput-

ers that it traverses on it’s way to the destination machine.

TRANSMISSION CONTROL PROTOCOL (TOP)

A means of Sending data over the lnternet with guaranteed delivery.

TRANSMISSION CONTROL PROTOCOL/INTERNET PROTOCOL (TCP/IP)

A suite of protocols the Internet uses to provide for services such as e-mail,

ftp, and telnet.

USER DATAGRAM PROTOCOL (UDP)

A means of sending data over the lnternet without guaranteed delivery. Also

known as “connection|ess" protocol, it is used for data such as RealAudio®.

UNIVERSAL NAMING CONVENTION (UNC)

A way of accessing a file or directory on another computer. For example: I!

hostlshareldlrectoryifile (“share” refers to the alias used to make the resource

available.)

VIRUS

A self-replicating code segment that can infect a computer or network, caus-

ing minor to major damage
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VPN

Virtual Private Network: A secure channel used to transmit data over a public
network

WINSOCK

Windows Sockets. A Windows component that connects a Windows PC to

the Internet using TCPIIP.

WORKSTATION

Any computer connected to a network.

X.5D9

An ISO format standard for client and server certificates.
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AVENTAIL CONNECT 3.1/2.6 ADMINISTRATOR'S GUIDE

‘:3 1996-1999 Aventaii Corporation. All rights reserved.

808 Howell Street. Second Floor

Seattle, WA 98101
USA

http:h'www.aventail.comI

Printed in the United States of America.

TRADEMARKS AND COPYRIGHTS

Aventail is a registered trademark of Aventail Corporation. AutoSOCKS. Internet
Policy Manager, Aventail VPN, Aventail VPN Client. Aventail ExtraNet Center,
and Ave-ntail ExtraNet Server are trademarks of Aventail Corporation.

Socks5Toolkit is a trademark of NEC Corporation. MD4 MessageDigest Algo-
rithm and MD5 Message-Digest Algorithm are trademarks of RSA Data Security.
Inc. Microsoft, MS, Windows, Windows 95, Windows 98. and Windows NT are

either registered trademarks or trademarks of Microsoft Corporation. ReaIAudio
is a trademark of RealNetworks. SecurlD. SoftlD, ACEfServer. and SDTI are

either registered trademarks or trademarks of Security Dynamics Technologies,
Inc. '

This product includes software written by Dr. Stephen Henson.

Other product names mentioned in this manual may be trademarks or registered
trademarks of their respective companies and are the sole property of their
respective manufacturers. -

' © 1995-1996 NEC Corporation. All rights reserved.

© 1990-1992 RSA Data Security. Inc. All rights reserved.

© 1996 Hiifn Inc.. including one or more U.S. patents: 4701745, 5016009,
5126739, and 5146221, and other patents pending.

© 1996-1997 Con sensus Development Corporation. All rights reserved.
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Introduction

Welcome to the Aventail Connect 3.1f2.6_secure Windows client for 16- and 32-
bit Windows applications. The client component of the Aventail ExtraNet Center,
Aventail Connect is a secure proxy client based on SOCKS 5. the IETF standard

for authenticated firewall traversal. Aventail Connect delivers enhanced security
and simplifies SOCKS deployment for users and network managers.

Aventail Connect redirects Winsock calls and reroutes them based upon a set of
routing directives (rules) assigned when Aventaii Connect is configured. (For
more information about Winsock, TCPIIP. and general network communications,
see “Getting Started")

On larger networks. Aventail Connect can address multiple SOCKS 5 servers
based on end destination and type of service. This feature enables network

administrators to effectively monitor and direct network traffic.

Aventail Connect is a proxy cl ient, but when used with SSL it provides the ability
to encrypt inbound or outbound information.

Features of Aventail Connect:

- Aventail Connect supports X. 509 client certificates for strong authenti-
cation with SSL (when encryption is enabled)

- Automated Customizer utility simplifies client configuration. distribution,
and installation

- SSL compression detects low bandwidth connections and compresses
encrypted data (when encryption is enabled)

- Secure Extranet Explorer (via Extranet Neighborhood icon on desk-

top) allows users to securely access Windows or SMB hosts over an
extranet connection (Windows 95. Windows 98. and Windows NT 4.0

only)

~ Supports Winsock 2 (LSP) applications in Windows 98. and Windows

NT 4.0, and Vlfinsock 1.1 and Winsock 2 applications in Vliindows 95

- Supports WinSock 1.1 applications in Windows 3.1, Vtfindows for Work-

groups 3.11, and Windows NT 3.51

- MultiProxy feature allows you to use a SOCKS server or an HTTP

proxy to control outbound access

- Allows the use of port ranges for redirection rules

- Provides integration with SoftlD"“ and SecuriD"“ tokens

- Provides automated installation and uni nstallation

- Credential cache timeout feature allows administrators to specify when
credentials expire

o Provides optional password protection for configuration files

- Supports both SOCKS v4 and SOCKS v5 (RFC 1928 and RFC 1929)
standards

Aventail Connect3.1/2.5Admfnistrafor’s Guide - 1
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Enables network redirection through successive extranet (SOCKS)
' servers

- includes a logging utility to troubleshoot probiems with network connec-
tions

v Includes a Configuration wizard for simplified step-by-step creation of
configuration files

- Allows internal network connections to pass through without interfer-
ence

- Supports multiple authentication methods including SOCKS v4 identifi-
cation, usernameipassword, CHAP, CRAM, HTTP Basic (username!
password), and SSL 3.0

__.7__.. NOTE: Not an versions of Aventaii Connect have encryption
""“ ' enabied.
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ABOUT THlS DOCUMENT

This Administrator’s Guide provides basic information about Aventaii Connect. It

includes entry-level data for non-technical users. plus installation, setup, and
configuration information for network administrators. This information is also

available via Aventail Connect Help and the Aventail Web site at

http:itwww.aventaiLcomicontentiproductstdocst.

DOCUMENT ORGANIZATION

This document is divided into three main sections: Administrators Guide. Utili-
ties Reference Guide. and Troubieshooting.

The Administrator's Guide describes procedures for setting up, installing. and
configuring Aventail Connect for individual and multiple networked workstations.
It also describes how to create a customized Aventail Connect package for distri-
bution to multiple users.

The Utiiities Reference Guide describes the Aventail Connect system menu
commands and utility programs. It contains detailed information about using the
S5 Ping utility and the Logging Tool, and documents the authenticationiencryp-
tion modules and settings.

The document concludes with Troubleshooting and the Gtossary

You can aiso use the Quick Start Card. a short document designed to help you
install Av-entail Connect to an individual workstation, and the Aventail Connect
flowchart, at -

http:iiwww.aventai|.comtcontentsisoIutionsipresentationstquickstarti
vpnclie nt.pdf.

Aventait Connect 3. 1/2. 6 Administrator’s Guide - 3
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DOCUMENT CONVENTIONS

The following typographic conventions are used in this document. Exceptions
may be made for online material; for instance, italicsmay be difflcuit to read
online.

  
 Filenames. extensions. directory names,

keynames, and pathnames.

Command-line commands, options. and portions
of syntax that must be typed exactly as shown.

  
  
 

Dialog box controls (Edit... buttons), e-mail
addresses (support@aventail.com), URLs,
(www.aventaiI.corn), and IP addresses

(165.1 21.6.26).

 

  
  

 
 

 
 
 

Plaoe holders that represent information the user
must insert.
 

SEE ALSO: A reference to additional useful inforrnation.

NOTE: information the user shouid be aware of to increase

understanding and/or efficiency or the software.

 
avoid a network poiicy/software coniiict, oriapse, which - CAUTION: An operationai item that the user shouid be aware oi‘ to
may create a r'viiNOR security flaw.

avor'd a network poiicy/software conriict, or iapse, whichWARMNG: An operationai item that the user should be aware of to
may create a SERiOUS security flaw.
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AVENTAIL TECHNICAL SUPPORT

Contact Aventail Technical Support if you have questions about instaitation. con-
‘ figuration, or general usage of Aventail Connect. Refer to the Aventail Support

Web site, at http:ii'www.aventaiI.comrindex.pl1tmlisupport.'
online_support.phtml. or the Aventail Knowledge Base, at
httpziiwwwaventail.comlindex.phtn1l'?pago_id=03110000. for the latest tech-
nical notes and information. Refer to the readme . txt documentation for addi-

tional information not included in the Administratofs Guide.

Aventail Technical Support:

Web site: httpmlwww.a\rentail.comiindex.phtmlisupportiindexphtml
, E-mail: support@aventail.com

Phone: 206.215.0078

Fax: 206.215.1120

Aeour AVENTAIL CORPORATION

Aventail Corporation is the leading vendor of extranet software. its extranet solu-

tions allow organizations to secure their networked communications and man-
age their employees’ access to the Internet. Building an extranet gives
organizations the ability to dynamically create a private communication or data

channel over the Internet. Aventail"s adherence to open security standards sim-
plifies extranet deployment, enables interoperability. and leverages corporations’
existing network investments. Its extranet solutions allow companies to extend
the reach of their corporate extranets to customers. partners, remote offices. and
worldwide employees.

Aventail Corporation
808 Howell Street. Second Floor

Seattle. WA 98101
Phone:206.2‘l5.1111

Fax'.206.215.‘l120

http:iIwww.aventai|.comi

info@aventai|.com

Aventaii

An aventail is a piece of chainrnail armor worn around the neck area. in the 14"‘

century, knights wore an aventail to protect themselves while in combat. Today,
Aventail continues the tradition of protection by allowing organizations to
securely communicate over the Internet.
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  ' i"itldiiiinis'tr'ator’s Guide 

This section includes procedural and background information on installing Aven-
tail Connect on both single and networked workstations. it includes:

- "Getting Started," with brief explanations of network security and com-
munications

- Definitions of SOCKS and Aventail Connect

- Avantail Connect platform and installation requirements, with an intro-
duction to Winsock 2 and LSP architecture

- "Installing Aventail Connect," which includes network diagrams of
Aventail ExtraNet Center and SOCKS v4-based server configurations

- Directions on how to create and edit configuration files, and an intro-
duction to the Aventail Custcmizer

NOTE: Aventail understands the importance of a flexible, easy-to-use
instatiation process. if you have feedback regarding the Aventai!
Connect installation procedures, or it there are additional features

you want to see implemented, please e~mail comments to

support@aventail.com. Your input is appreciated.

 

GETTING STARTED

if you are new to Aventail Connect technology, the following section will help you
understand what Aventail Connect is and does, and its relationship to network
security in general.

NETWORK SECURITY IN A NUTSHELL

Escalating security threats are forcing companies to seek ways to safeguard
their corporate networks and the information they exchange. The first response
to these concerns has been the development of security firewaIIs—soltware bar-
riers that control the flow of information. But firewalls are not designed to handle
complex security issues, such as monitoring network usage. providing private
communication over public networks. and enabling remote users to gain secure
access to internal network resources.

Enter SOCKS v5, an Internet Engineering Task Force (IETF)-approved security
protocol targeted at securely traversing corporate firewalls. SOCKS was origi-
nally developed in 1990. and is now maintained by NEC. SOCKS acts as a cir-
cuit—leveI proxy mechanism that manages the flow and security of data traffic to
and from your local area network (LAN) or extranet. An application whose traffic

Aventail Connect 3. 1/2. 6 Administrator's Guide - 6
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is proxied by SOCKS is considered "socksified." SOCKS is more than a stan-
dard security firewall. Other features:

- Client Authentication: (SOCKS v5 only) Authentication allows network
managers to provide selected user access to internal and external
areas of a network.

- Traffic Encryption: (SOC KS v5 only) Encryption ensures that network
traffic is private and secure.

- UDP Support: (SOCKS v5 only) User Datagram Protocol (U DP) traffic
has traditionally been difficult to proxy, with the exception of SOCKS v5.

- Aventail Connect supports X509 client certificates within SSL.

- Cross-Platform Support: Unlike many other security solutions. SOCKS
can be used on venous platforms. such as Windows NT. Windows 95.
Windows 98, and various forms of UNIX.

NOTE: Not all‘ versions of Aventail Connect incfude the SSL module for
encryption. 

WHAT Is AVENTAIL CONNECT?

Aventail Connect is the client component of the Mental! ExtraNe_t_ Center; -l_j_k_ven- -_
l~‘..3..i.!..Qsinnssi._tt°iK§..ivii.li.,i.|29;.i‘?+li9iitsi.i.._E?$traN9t 3ervsi.. tfie.,SQCKS .5 server"¢on1-. . -.
po'nent_.of’the Av_ehta_iI Extralfilot Center; You can use Aventail Connect as a
simple proxy clientfor managed outbound access. and for secure inbound
access.

Aventail Connect automates the "socksitication” of Transmission Control Proto~

colilnternet Protocol (TCPIIP) client applications, making it simple for worksta- _
tions to take advantage of the SOCKS v5 protocol. you run _Al.i.er_ltail_ -

' C..onnect.on your system. it. automatically |.'ou_tes. 3.PP.F0Pfi.8t.9...U°tW9.fk- traflis=.fr9m
:1 Viiinsocls (Windov.v.s.s9clrets) application to an eizstrsnei (SOCKS). s-.erv.er.. or...
thrbush. successive serttersi. (‘M.n.S.o.c.k is .31 Vxindovifs.tistrnmientfithat...s:'9rine¢ts.a. .
\i'li_indows_F3C_ to the Internet‘using__TC_P.{lP.) The_ SOCKS serv's'r.then sends the‘ . '
traffic to the Internet or the external network. Network administrators can define
a set of rules that route this traffic.

Aventail Connect is designed to run transparently on each workstation. without
adding overhead to the user’s desktop. In most cases, us§_rs_ \v_\i_i_l_l_i__r_1'_ter_'a__q:.~t,__s_\r.ritl_‘i_‘_'_
Aventail Connect only _when it prompts them to enter authentication credentials
for a connection to a secure extranet (SOCKS) server. Users may also occasion-
ally need to start and exit Aventail Connect, although network administrators
often configure it to run automatically at startup. Aventail Connect does not
require administrators to manually establish an encrypted tunnel; Aventail Con-
nect can establish an encrypted tunnel automatically.

To understand Aventail Connect, you first need to understand a few basics of
TCPHP communications.

Aventaii Connect 3.1/2.6 Administrator’5 Guide ' 7
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TCPIIP COMMUNICATIONS

Windovvs TCP/IP networking appiications (such as telnet, egrnail, Web'brow.sers,3'
and. ftp)" use WinS'ock to gain access to networks orthe "Internet. Winsock is the
core component of TCPIIP under Windows, and is the interface that most Win-

dows applications use to communicate to TCPIIP.

WINSOCK CONNECTION TO A REMOTE HOST

Via Winsockj an application goes through the following steps to connect to a
remote host on the lnternet or corporate extranet:

1. The application executes a Domain Name System (DNS) lockup to convert
the hostname into an Internet Protocol (IPJ address or, in rare cases, itwill do
a reverse DNS Iookup to convert the IP address into a hostname. If the appli-
cation already knows the IP address, this step is skipped.

2. The applicationrequests a connection to the specified remote host. This
causes theunderlying stack to begin the TCP handshake, when two comput-
ers initiate communication with each other. Vtihen the handshake is complete,
the application is notified that the connection is established, and data can then
be transmitted and received.

3. The application sends and receives data.

Avenraii Connect 3. 1/2. 6 Ao'ministraior‘s Guide - 8
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WHAT Does AVENTAIL Comuecr Do?

Aveniaii. Connect. s.|.ips.in between. W1nSo.cls..am;1..'t'ha._underly.ing.IQ'Pi.l.F! .
(Sea di39L$LT|_.9§.L1l.‘£=I&§§D'.§l?PJi0§!j9.[1IL‘ta.L_$§,P.9j¥1§911_\M_.l1§Q;0LS and -the T_c_Pi' -
‘P. s..tac._.!.<J Am.-i.ei.l; Q9;nn'..ei9t_ Layered 5‘;enri9e.Provider..(L§E);..AventaiI
Cs211.ne§cz;.-;..ai1; 9b.s;I.eo§;.9l.a.te'.l..(Qri1;ets2§.sina.it.rir. enl.=.rxp'.ti;ri9,;i.L_for ekamplél berm -'
routing it to the TCPilF?'stack for transport over the network. The routing is deter-
mined by the rules described in the configuration file. -

Windows TCP.-1P application
[uses either WinSocl<1.1 or

Winsuck 2)

in insect 1 .1
(cane-en: all:
Ia'i'||iI1Suck2]

- Multiple LSF"s can
A“'°”ta" c_°”"'°Ft be installed at this
[Layered serulce Provider} level

TCPilF' stack

Physical network

Windows TC PIIP applications and Aventail Connect have no direct contact with

one another; instead. each of them communicates through Winsock. Multiple
LSP applications can be installed at the LSP level.
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NOTE: Aventafl Connect does not alter or replace Wl'nSock or any other
core TCP/lP components (files) provided by the operating system. 

when _the Aventail Connect LSP receives a connection request,'it determines _
whether or not the connection _n_e__ec|s to be redirected {to an Avgntgit Extrahlet _
§§.El£6.fJ.linQtQ.!.§!nQT¥Q1§d..(in S_$I_.L V\i1_el1..reclire¢il9ri ancl;e.ns.rye'ti<.j=n
es.ser¥i._AventaiI C:;o_n,rJ.e..9t.siiuplr passes l.h.e..con.ne¢tio.n' raqu'est;- and an"y"s.ubse- I
quent transmitted'data,. _to the TCPIIP stack.

The two most popular versions of Wlnsock are versions 1.1 and 2. Aventaii Con-

nect 3.1. like all LS Ps, requires Winsock 2; Winsock 1.1 does not support l.SPs.
Winsock 2 includes backward-compatibility with all winsock 1.1 applications.
Not every platform supports Winsock 2 and its LSP structure.

- Windows 98 and Windows NT 4.0 support \MnSock 2 natively. (Wm-
dows NT 4.0 requires Service Pack 3 or above. available from
Microsoft.)

- Windows 95 supports Vtinsock 1.1. Windows 95 can also support Win-
Sock 2. but you must install a patch {available from Microsoft) to add
support for Winsock 2.

- Windows 3.1, Windows for Workgroups 3.11, and Windows NT 3.51 do .
not support Winsock 2; they support only Winsock 1.1.

For those platforms that do not support Winsock 2 and LSP applications, Aven-
tail includes Aventail Connect 2.6 on the Aventail Connect 3.1i‘2.6 CD. Avenlail

Connect 2.6 was designed for operating systems that support only Winsock 1.1.
On Windows 3.1, Windows forworkgroups 3.11. or Windows NT 351 operating
systems. setup will install Aventail Connect 2.6. If you are working on a windows
95 operating system. setup will detect whether you have installed the Microsoft
Windows 95 Winsock 2 Update. If setup detects the Microsoft update. which
upgrades Windows 95 to support Winsoclt 2. setup will install Aventail Connect
3.1. If setup does not detect the Microsoft update. it will install Aventail Connect
2.6. -

The Aventaii Connect 2.6_use_r_i_r1_ter_fac_e isidenlicali to th_at_ _of Avent_a_i__l_ _Cq_n_ne_c_t _ _
3.1; however. Av_entai_I_..Connect 3.1 includes MuitiF?I'o'x3t.'fuhcfionality (s'e7&7'Mull1s -- - '
ple Firewall Traversali‘). Aventail Connect 2.6 does not include Mu|tiProxy. '

In the future, more Windows applications may require Winsock 2.

During installation, setup determines which version ofAventail Connect to install.

On Winsock 2 platforms. Aventail Connect 3.1 is installed. On Winsock 1.1 plat-
forms, Aventail Connect 2.6 is installed. The following table shows how setup
determines which version of Aventail Connect to install.
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Windows 98.
Windows NT 4.0

Windows 95 With Microsoft

patch: Winsoclt 2

Without Microsoft Aventail Connect 2.6
patch: Vluinscck 1.1

M Avenlail Connect 2.6
   

‘Windows 3.1, ‘
Windows for Wcrkgroups 3.11,
Windows NT 3.51

You can create custom packages that include one or both versions or Aventail
Connect (3.1 and 2.6). Setup will determine which version to install on each

workstation. (For more information. see "Custon'Iizer.")

Wmoows 95 AND WINSOCK

The Microsoft Windows 95 Winscck 2 Update upgrades Winscck 1.1 to Win-
Scclc 2 in Windows 95. This patch (filename w95ws2setup . exe) is available
from the Microsoft web site. at _l1ttp:ttwww.micrcscft.ccmlWindows95.ldcwn-

icadstccntentstwuadmintcc|sts_wunetwcrkingtcclsl'W95Scckets2!
defauIt.as p. Unless you need specific Aventail Connect 3.1 features. Aventail

recommends that you do not upgrade from Winscck 1.1 to Winscck 2. If you do
not upgrade to Winscck 2. Aventail Connect 2.6 will be installed on Windows 95
systems.

it you do need to install the Microsoft Windows 95 Winscck 2 Update, follow the
instructions provided by Microsoft. Reboot your computer after upgrading, prior
to installing Ave-ntail Connect.

How Does AVENTAIL CONNECT WORK?

The following three steps are identical to standard Vvinsock comm unications

steps described above; however, nested inside them are additional actions and
options introduced by Aventail Connect.

1. The application does a DNS lockup to convert the hcstnarne to an IP address
or, in rare cases. it will do a reverse DNS lockup to convert the IP address to a

hostname. If the application already knows the IP address, this entire step is
skipped. Otherwise, Aventail Connect does the following:

« lrine:.bio..st_na..me matches.a.l¢tcaI'.d9mai..n.st'tino.ctr,sl9e.s‘:.tiot_.mat¢it;éIJedi~--I --
rectiqri rule, Avantail connect. passes..the'..ilant'e i:lu.ecr.i._~'.
tliroush t9.t.he_1TCPi.lP.s.ta<.=k. on t.i1eIqc_a|-';iti9rltst§tti9c..;Ih ='.|?.CF«'|P étack-.
performs the lockup as if A-ventail Connect were not running.
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- If the destination hostname matches a redirection rule domain name
(i.e., the host is part of a domain we are proxying traffic to) then Aventail
Connect creates a false DNS entry (HOSTENT) that it can recognize
during the connection request. Aventait Connect wi_Il _f_or_wrd_ the host: ,
name to the extra_n_et_(SQ_CKS) server in step 2 and the SOCKS server
performs the hostname resolution.

. If the DNS proxy option is enabled and the domain-cannot be looked ‘up 2
directly, Aventail Connect creates a raise DNS entry that it can recog-
nize later. and returns this to the calling application. The false entry tells
Aventail Con_ne__ct_ that _the DNS lookup mus_t__be proxied._ an_d___tha_t _it
§_9.'.‘ld the _futly',quaIifi_ed hostnameto the SOCKS server with the SOCKS” "
connection request. '

CAUTION: The reverse DNS process can create unexpected
delays. causing Aventaii Connect to behave unpredict-
ably. Aventail recommends that you do not enable this
option unless you specifically require the Reverse DNS

functionality

2. The application requests a -connection to the remote host-. This causes the
underlying stack to begin the TCP handshake. when the handshake is com-
plete. the application is notified that the connection is established and that
data may now be transmitted and received. Aventail Connect does the
foilowingz

a. Aventail Connect checks the connection request.

- If tl_1e.;equest contains a false DNS entry (from step -1), it will be
proxied.

- lf tti1e‘.raqu.e.st_t;ontains a-...rotitebIe.lEt_e,c.idtés;s.-; s.nd..th,.e frute$..i.i.t._tt1e.-.-_;
.c9nfi9u.ts.tis2n..ti.!:g..ssir.itm!isl..tte.p.r92tiedi._£wsnta -.

_DfQQit1'1i'§. ICP. handshake-"with" server designated _'
in the-co'nfig'L’iratibn file;

- l.f.fl1e.re<iL-lest ridrihtins :3. .tei..a.i,.l.P adttils$§§.r.1<t the ciififiduratibn file“
rule says that it does not need to be p,rg;<ieHd, the request will be
passed to Winsock and processing jumps to step 3 as if Aventail
Connect were not running. -

b. Wh_en the connection is completed. Aventail Connect begins the
SOCKS negotiation.

« It sends the list of authentication methods" enabled in the configu-
- ration file.

- Onss the. server selects. an’. at.r_ttts.e_nti.<.=a'ti.O.n,_rrt€5t!t°st..Atfe.ntail Cort
nect executes the specified auth_'enticatio'n p__ro__oessing_. _.

- It then .senc.I_s the proxy request to the éictraiiet t$QCK'S)' server.
This in_c_lud_e_s ejth_er_the IP address provided by the application or
the DN3 entry (hostname) provided in step 1.

c. when the SOCKS negotiation is completed, Aventail Connect notifies

the application. From the applications point of view, the entire SOCKS
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negotiation, including the authentication negotiation. is merely the TCP
handshaking.

3. The application transmits and receives data.

if an encryption module" is enabled and selected by the SOCKS server. Aven-
tail C..o.r.insct encrypts 1|.’-9 da..ta__ on itswax to the.-serv§r.on' behalf:-.f.the appli-
cation. If data is being'_re'tum'ed,-Aventaii Connect. decrypts it so that-the:
application sees cleart'e‘2'<t'datsr. -

AVENTAIL CONNECT PLATFORM REQUIREMENTS

The following table lists the minimum system requirements for each of the plat-
forms that Aventail Connect supports.

Windows 98; x36-based or Network—accessible

Windows NT 4.0 Pentium personal SOCKS v4 or V5 compliant
(requires computer server
Microsofl Service

Pack 3 or above)

Windows 95; x88-based or Network-accessible

‘Windows NT 3.51 - Pentium personal SOCKS v4 or v5 compliant
computer server

Windows 3.1; x86-based or Network-accessible

Windows for Pentium personal SOCKS v4 or v5 compliant
Workgroups 3.11 computer server

 
Aventail Connect 3.1 runs on the following operating systems:

- Windows 98

- Windows NT 4.0 (with Service Pack 3 or above. available from
Microsoft)

» Windows 95, with the Microsoft Winsock 2 update (To install Aventail
Connect 3.1, you must upgrade Windows 95 with the Microsoft Wm-

Sock 2 update prior to Aventail Connect installation and setup. If you do
not install the Microsoft patch. Aventail Connect 2.6 will be installed.

For more information, see "What Does Aventail Connect Do‘?".)

Aventail Connect 2.6 runs on the following operating systems:

- Windows 3.1

- Windows for Workgroups 3.11

- Windows NT 3.51

- Windows 95. without the Microsoft winsock 2 update (If you do not
upgrade Windows 95 with the Microsoft Wtnsock 2 update, Aventail
Connect 2.6 will be installed. For more information. see "What Does
Aventail Connect Do?".)

Avenrail Connect 3. 1/2. 6 Admr‘nr’strator’s Guide - 1' 3
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NOTE: A lrliinsock-compatibie 16- or 32-bit TCP/IP application must be
instalied and configured prior to running Aventaii Connect. This

can be the Microsoft-provided TCP/IP stack or a third—party TCPI
iP stack.

 

INTERFACE FEATURES

The following table lists the interface features for each platform. Each of these
features is discussed in greater detail later in the Administrator's Guide.

.... .I- ‘

Vlfindows 95, Stan\Programs Double-click In system
Windows 98. \AventaiI Aventail Extra net tray available
Windows NT Connect menu connect Neighborhood
4.0 icon in icon on

system tray desktop

Windows 3.1. Aventail ‘ _ Not available Minimized
Windows for connect icon on desktop
Workgroups in Av-entail
3.11. Connect

Windows NT program group
3.51 window 

INSTALLATION SOURCE MEDIA

Regardless of platform, Aventail Connect can be delivered on CD or as a net-
work-clelivered. self-extracting archive file.

- CD: The CD contains the Aventail Connect setup program,
setup.exe. The setup program allows for an administrative setup. It
also contains the Adntinistratofs Guide and the User's Guide in the

\docs directory. formatted for Adobe® Acrobat Reader.

- Network-delivered Source Media: The network-delivered source

media is a se if-extracting archive containing the required diskidirectory
structure within the archive file. The executable automatically extracts
the Aventail Connect installation files and initiates setup. The archive

filename will be similar to as3 ls .exe . This archive, or package, will
also be available on the CD (located in the Utilities directory) to be
used with the Customizer application. For more information, see the
"C ustomizer" section.
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INSTALLING AVENTAIL CONNECT

After your Aventail ExtraNet Server is set up. Aventail Connect can be installed

to a singie workstation or to multiple networked workstations. In either case. you
must perform an initial installation of the software and create one or more config-
uration (.cfg) files. This procedure is described under "Individual installation."

Once the initial installation is complete, you can then install to a series of net-
worked computers using the instructions and information described under "Net-
work Installation."

NOTE: To install or uninstaii Aventail Connect on Irlfindows NT

machines, you must have administrative priviieges an the
machine (but not necessariiy on the domain). 

If you are upgrading from an earlier version of Aventail Connect (AventaiI VPN
Client or Atientail AutoSOC K3). the following message may appear on your
screen if you install a custom setup package using Aventail Customizer. This is

not an error message. If this message appears, click OK and reboot your com-
puter.

 
CONFIGURATION FILES

integral to the initial installation of Aventail Connect is deciding how SOCKS traf-
fic will be redirected through the network. Network redirection rules (used to
determine if and how SOCKS redirection will occur) are defined in the Aventail
Connect configuration (.cfg) file. Configuration files are initially created at the
end of the installation process; however. you can add. edit, and re move configu-
ration files at any time using the Config Tool (in Windows 95. Windows 98, or
Windows NT 4.0 via the Aventail icon in the system tray on the taskbar; in Win-
dows 3.1, Windows for Workgroups 3.11, or Windows NT 3.51 via the Aventail

Program Group). The process of creating one or more configuration files is
described under "Configuring Aventail Connect.”

If you are installing Aventail Connect on multiple networked workstations, refer
to “Network Installation” to determine the best method for maintaining and dis-
tributing configuration files. You can then proceed through the initial installation.
The Installation Wizard will guide you through the steps. culminating with the
option to create a configuration file.
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Cusrormzao CONFIGURATION AND DISTRIBUTION

The Aventail Customizer is a utility that allows network administrators to custom-

ize Aventail Connect installation packages for distribution to multiple client work-
stations. Giving network administrators control over how setup packages are
configured eliminates the need for end users to make installation and setup deci-
sions at their workstations. The installation package is a self-extracting execut-
able 'file. You can customize this file by adding license file, configuration file, or
setup information for different authentication and encryption policies to meet var-
ious client-access needs of individuals or workgroups. You can customize con-
figurations for multiple users and then distribute the package, providing easy
access, download, and installation for users. You can reconfigure the Aventail
Connect installation package anytime your network topology or security profiles
change.

For more information about the Aventail Customizer, see the "C ustomizer" sec-
tion.

INDIVIDUAL INSTALLATION

Before running setup, close all open Windows applications.

_ T'.~‘.’..i_l!5__*_?!!.‘..f.’.‘.‘.'E!?.'_‘._*"i' C°""‘?°.*...

1. Installation procedures vary slightly, depending on which media source you
use:

- If you are installing directly from CD-ROM, run se|:L1p.exe from the
Av-entail Connect directory.

- If you are installingfrom a network-delivered self-extracting archive,
simply execute the archive file. This will extract the installation files and

automatically launch the setup program.

The Aventail Connect Installation Wizard then guides you through the process
of installing the A-Iientail Connect application. -

NOTE: You will be asked during the installation procedure ifyou would
like AI/entail Connect to be run automatically during starlup. in
most cases, you will select yes. Exceptions to this can be deter-
mined by the network administrator.

 

2. At the end of the setup program. you can select Yes, I want to view the
README file in the Setup Complete dialog box. This opens the
rreadrne . txt file, which contains the latest information on Aventail Connect. ‘

-OR-

Simply click Finish in the Setup Complete dialog box to complete the setup
' program.
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k.‘Il.I[.)' |‘.1.11I:fl1- ‘H-3 W‘.1. "C"

3. The setup program will then ask you if you want to restart your machine now
or later.

Ave-ntai! Connect 3. 1/2. 6 Adminsfrators Guide - '1?
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4. After restarting your PC. Aventail Connect will launch automatically if, during
installation. you selected Yes when asked if Aventail Connect should be

added to your startup directory. (If, during installation, you specified that Aven—
tail Connect not be added to the startup directory. start Aventail Connect from
the Programs menu.)

5. Aventail Connect will ask you if you want to run the configuration wizard.

If you ciick Yes, then the configuration wizard will launch to help you create a
new configuration file. '

If you click No. then Aventail Connect will ask you to select a configuration
file.

6. After creating or selecting a configuration file‘. Aventail Connect will finish its
installation procedure.

To uninstall Aventail Connect

The procedure to uninstall (remove) Aventail Connect varies depending on
whether you are running a 16- or 32-bit Windows operating system.

- To uninstall Aventail Connect front Windows 95. Windows 98. and Win-

dows NT 4.0. double-click Addi'Remove Programs in the Control
Panel window. click Aventail Connect on the list of programs on the
lnstalliuninstall tab. and then click Addi'Remove.

- To uninstall Aventail Connect on Windows 3.1. Windows for Work-

groups 3.11. or ‘Mndows NT 3.51. use the Uninstall icon in the Aven-

tail Connect program group.

NETWORK INSTALLATION

in general, the process of installing Aventail Connect to multiple networked
workstations involves selecting a file server to use. creating a staging area for
the Aventail Connect software. and placing the Aventail Connect package in a
shared network directory or other publicly accessible location. Additional options
include adding a default configuration file. license file. certificate and roots files.
and SEEHosts fiies. You must place Aventail Connect files on a network drive
that can be accessed as a mapped drive or. for Microsoft networks, via a UNC

path name (\\computer I name\share. narne\Connect) .

An executable archive file {with a filename similar to as31s . exe) automatically
extracts the Aventail Connect installation files and initiates setup. This archive.
or package. is located in the Utilities directory of the CD and can be used in con-
junction with the Customizer application. (For more information, see "Custom-
izerf’) The package can also be manually configured to suit your network
specifications. The default package includes all of the core Aventail Connect
files, but does not include the custom network information.

Nerwoa-Ken CONFIGURATION FILE SETUP

There are a number of ways to set up networked client configuration files. These
are the most common:
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o Remote UNC: Remote client configuration file on a ‘windows share

using UNC path and filename (e.g., \\i nt er naJ.\::ommc-n\a . cfg)

- Local Configuration File: Local client configuration file common for all
users, but distributed via a locally stored Aventail Connect package

- Remote Web Server: Remote configuration files stored on a Web
server using URL (e.g., httpzflinternallacfg)

 

 
 

- Configuration file can

be centrally maintained.

' No local caching
required.

  
 
 

 

 

  

 

  
 

- File server must be on

local network. If file

server is unavailable,
Aventail Connect will
not function.

Windows share

using UNC path
and filename

Remote UNC  

  
 

 
 
  

  

  

 

 

 

Locally stored

setup package
- Does not require - Configuration files

network connection; cannot be centrally
configuration file is maintained.
always available.

Local

Configuration
File

 
 
 

 
  

Remote Web
Sewer
 
 
 

 
 
 
 
 

 
 

 
 

  

- Configuration file can - Requires Web server.

be centrally maintained. - Requires network

« Connection to web connection for updates.
server can be made

across the lntemet, and

can traverse proxies.

- Supports
authentication and

encryption.
0 it Web server is

unavailable. locally
cached copy can be
used.

 

ADMINISTRATOR-MAINTAINED SHARED CONFIGURATION FILES

This is the most desirable configuration method-—multiple workstations sharing
one or more administrator-maintained configuration files located in a common

directory. The network administrator maintains the configuration file, and the
administrator can quickly adapt any changes to network topology through a sin-
gle configuration file. For example:

- A single networked (usually read-only) configuration file is shared by
more than one client workstation. This method is appropriate when mul-
tiple workstations share identical traffic routing rules. '

- Multiple configuration files are shared by multiple workstations. This
option is useful when you have workstations organized into functional

groups (engineering. marketing, accounting. etc.) with group-specific
redirection‘ rules.
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SHARED CONFIGURATION FILE DISTRIBUTION

Shared configuration files can be easily distributed and. if necessary, updated
via the network or a Web server. Aventail recommends that you test all configu-
ration files before distribution.

You can distribute shared configuration files with the Aventail Customizer. This

automated wizard allows you to create custom setup packages for multiple users
and then store the packages in a networked directory. providing easy access,
download. and installation for users. You can include multiple local andior
remote configuration files. For more information, refer to the "Customizer” sec-
tiort.

., TF.’...“?_5*"“’“t‘_3.._fi. .5_'.‘§_’_“3.'F'. F9,'."fiS""“Pfl..f_i'°

There are three methods for distributing shared configuration files.

- Remote UNC: Copy the file to a Microsoft or Novell network drive

accessible by all users, or to a Microsoft Windows workstation support-
ing UNC-sharing for file resources. (Both the 16- and 32-bit versions of

Aventail Connect support specification of the configuration file using the
Microsoft UNCs.) If you copy the file to a network drive, make sure that

users configure Aventail Connect to load the configuration file located
on the mapped drive. You can preconfigure this information for users
from a package install.

- Local Configuration File: Create a shared configuration file to be
installed on workstations during the standard Aventail Connect installa-
tioniupgrade process. Whenever Aventail Connect is installed or

updated, it will automatically copy the shared configuration file to the
user’s workstation and set Aventail Connect to use it.

- Web Sewer: Copy the file to a Web server. The Web server can be

directly accessible to the workstation, or it can be behind a proxy
server. To keep configuration files secure. you can redirect the configu-
ration file connection. authenticated and encrypted. across firewalls.

Storing Remote Configuration Files on a Web Server

When you specify the remote configuration file in Aventail Connect,
include the entire URL (e.g., http:iiaventail.comiserver1iconfigcfg). You
can specify this URL in the Aventail Connect Configuration File dia-
log box, or with Customizer.

Aventail Connect keeps a temporary local copy of the remote configura-
ticn file in its program directory, with the filename _ashttpX.cfg, where X
is a number between 0 and 9. Keeping a local copy of the remote con-

figuration file allows the connection to the Web server to be proxied
(with authentication and encryption) if necessary. Whenever the remote
configuration file needs to be downloaded, Aventail Connect will check '
the cached copy of the configuration file to determine whether redirec-
tion is necessary.
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Avenzail Connect can download remote configuration files either every
time Aventail Connect starts or on a scheduled basis. You can config-
ure this setting in the Aventail Connect Configuration File dialog box,
or when adding a remote configuration file to a custom instaiiation

package with Customizer. when you add a remote configuration file
with Customizer. a cached copy of the file can automatically be added
to the package. -

To store reIjI_1_g_i_1_:e configuration files on a wiebwscrver

1. Place an Aventail Connect configuration file on a Web server.

2. If redirection through a proxy sewer is required to reach the Web server, con-
figure Aventail Connect to use a configuration file that can access the Web

server. If redirection is not required. skip this step.

3. With Avsntail Connect running, select Configuration File from the system
tray menu.

The Aventall Connect Configuration File dialog box will open.

4. Enter the URL and filename of the configuration file. e.g., http:i'iweb-
servencompany.coml'ofg_fiIesI'sample.cfg. Click OK.

 
5. Under "HTTP Config File Updating,” specify how often Aventail Connect will

download the configuration file. Click OK.

The configuration file will automatically be downloaded, and Aventail Connect

will begin using it immediately. A local copy of the configuration file will be
cached in the Aventail Connect program directory.

ADMINISTRATIVE SETUP

There are two ways to install Aventail Connect: from the setup program
(setup . exe), or from a setup package that you create using the Aventail Cus-
tomizer. The setup program (setup . exe) allows you to manually install Aventail
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Connect. With the Aventail Connect setup package, you can select options that
will customize setup based on your unique network environment. You can cus-
tomize the setup package through the Customizer Editor or the Customizer Wiz-

ard. The Customizer Editor is a dialog box that allows you to manually enter or
modify information about your custom installation package. The Customizer Wiz-
ard walks you through each step of creating a custom installation package.
Aside from the user-interface differences, the Customizer Wizard and the Cus-
tomizer Editor are identical. You can use both the Customizer Wizard and the

Customizer Editor to create or modify a setup package. For example, you can
create a package using the Customizer Wizard, then modify it with the Custom-
izer Editor.

CUSTOMIZER

The Aventail Customizer simplifies and customizes the installation and setup
process. Network administrators can reconfigure the self-extracting executable
installation package (included in the Customizer directory of the distribution CD)
to meet the various client-access needs of individuals or workgroups. Custom-
izer offers a centralized approach to network configuration; network administra-
tors can select the unattended setup mode, which eliminates the need for

' "individual users to answer any setup configuration questions. Specifying unat-
tended mode will cause the setup program to automatically install using default
values for any options not explicitty specified.

The setup program (setup . exe) allows users to select any available setup
options during installation of Aventail Connect. Customizer modifies the setup
control file of a custom package; this file controls all of the settings within the
setup package. before users receive the setup package. With a customized
package, users will receive an installation package based on the adrninistrator’s
defined settings. (For more information, see “Network lnstallation.")

As Customizer allows you to select various options to suit your setup and instal-
lation needs, the size of the setup package will vary, depending on which options
you select. If-size of the setup package is a concern, select setup options care-
fully to keep the package size manageable.

The Aventail Connect CD includes both versions of Aventail Connect (3.1 and
2.6). You can create custom packages that include one or both versions of Aven-
tail Connect; setup will determine which version to install on each workstation.

(For more information, see “What Does Aventail Connect Do?")

Aventail Connect requires a valid Aventail license file (ave ntail . alf) and one
or more configuration (.<.'fg) files in order to function properly. Before installing
Aventail Connect, make sure that users have these files. If users do not have a

valid license file andior configuration file(s), Aventail recommends that you
inctude them in the installation package.

RUNNING CUSTOMIZER

The Customizer and the Aventail Connect installation package are included in
the Customizer directory on the Aventail Connect CD. Before running Custom-
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izer, you must copy Customizer from the Aventail Connect CD to the Iocat drive.

You must also modify the Customizer attributes so it is not read-only.

.To run Customizer. double-click the Customizer icon in the Customizer direc-
tory. To run Customizer from your hard drive. copy the Customizer and Aventaii
Connect directories into a common folder on the hard drive.

when you run Customizer. you will be prompted to select either the Customizer
Wizard or the Customizer Editor.

 
- Customizer Wizard: This automated wizard walks you through the

process of creating a new instaltation package or modifying an existing
package. If you are unsure about which method to use, Aventail recom~

mends that you use the Customizer Wizard.

- Custornizer Editor: The Customizer Editor is a dialog box that allows

you to manually enter information about the package you are creating
or modifying.
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CUSTOMIZER WIZARD

if you are using the Customizer Wizard to create a new setup package or modify
an existing package, the Customizer Vifizard will display a Welcome... screen.
and will prompt you to enter the pathname of the package that you will be creat-
ing or modifying.

‘We omc to tha-

After you have specified the pathname of the package, the Customizer Wizard
will prompt you to:

- Specify which platform(s) to support

- Add a license file, or leave an existing license file in the package
- Add or remove configuration files

- Select X509 certificate files

- Select an extranet hosts (SEEHosts) file

- Specify a custom destination directory

o Specify whether or not to put program icons in a custom folder
- Enter com mend-line switches

- Specify whether or not to run setup in unattended mode

- Specify whether or not to add Aventail Connect to the startup directory

o Select any, all, or none of the following Aventail Connect components:
- Extranet Neighborhood (Secure Extranet Explorer)

- Configuration Tools (Config Tool and Configuration File command)

- Diagnostic Tools (Logging Tool and S5 Ping)

- Certificate Tools
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o install 32-bit support only (on Windows NT 3.51)

- Select any, all. or none of the following authentication modules:

- SSL (Secure Sockets Layer)

° CRAM (Challenge Response Authentication Method)

° CHAP (Challenge Handshake Authentication Protocol)

- UNF'W(Usemamei'Password)

- SOCKS4

» HTTP Basic (usernamefpassword)

v Specify whether or not to run a command after setup

Alt of the features listed above are optional.

After entering or modifying the package information. the Finished Installation
Package dialog box appears.

i.~:he-tllmali I
Ex‘: ‘. _.

  
' Clicking Finish saves your specifications and closes the Customizer Wizard.
Clicking Customize Further allows you to view the Custornizer Editor dialog
box, where you can manually edit any of the information about your custom
installation package.
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CUSTOMIZER EDITOR

If you select the Customizer Editor as your tooi to create a new setup package or
modify an existing package. the Customizer Editor dialog box will appear. In
this dialog box, you can manually enter or modify information about your custom
instaiiation package.

NOTE: To view a iist of tips on creating custom setup packages, click
Tips on the Help menu in the Customizer Editor diatog box. 

After entering or editing your setup package information in the Customizer Edi-

tor, click Save (or Save As) on the File menu to save your changes. To close the
Customizer Editor window, click Exit on the File menu.
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The options in the Customizer Editor are identical to the options in the Custom-
izer Wizard. These options are explained in the following paragraphs and tables.

Enter pathname

‘E}E::;;;}”l;’"”"'""“ EBi;iaFfcn_ATeFi§il lloense file
(must USE aventai J. . .31 E)

trusted roots file Enter name of trusted roots file

Client certificate file Enter name of file that contains
certificate

EiF.;}E(§ss; Hosts
File file

Destination directory Enter name of destination directoryD_.__..._:_.._.jJ_ .___.._.___,..._.- -. .___.._._.___. ..__...-._-._ .._. _

Program folder Enter name of program folder

"nun‘¢8'i+.r}l;}i&"';fi;i'i' 'é}1i§=.»}};.;'n'u'h'anJi;'ia;'r.;H’§rEe'Esting
setup

Command line switches Enter command line switches

Configuration Files Enter name(s) of local and.-‘or remote
configuration fllets) that Aventail
Connect will use

Configuration tools, certificate tools.
Diagnostic tools. or Extranel

Neighborhood

32-"bit support only. on
Windows NT 3.51

Unattended setup
modelautomatecl
inslallal ion

Add to Stanup Directory

Select platform Windows NT 4.0. Windows 98,
Windows 95 with 'WnSock2 upgrade.
Windows 95 without Winsock 2 '

upgrade. Windows NT 3.51. Windows

3.1. or Windows for Workgroups 3.11

The setup package options are discussed below.
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